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Introduction

Introduction
Overview
Use this guide to configure the following Cisco Stealthwatch™ Enterprise hardware and
Virtual Edition (VE) appliances for v7.1.3:
l

Stealthwatch Management Console (SMC)

l

Stealthwatch Flow Collector

l

Stealthwatch Flow Sensor

l

Stealthwatch UDP Director

l

Endpoint Concentrator

For more information about Stealthwatch, refer to the following online resources:
l

l

Overview:
https://www.cisco.com/c/en/us/products/security/stealthwatch/index.html
Appliances:
https://www.cisco.com/c/en/us/products/security/stealthwatch/datasheetlisting.html

Virtual Edition (VE)
You can use this guide to install and configure your virtual appliances.

Hardware
If you are configuring Stealthwatch hardware, install your physical appliances using the
Stealthwatch x210 Series Hardware Installation Guide before you start this
configuration.

Audience
The intended audience for this guide includes network administrators and other
personnel who are responsible for installing and configuring Stealthwatch products.
If you are configuring virtual appliances, we assume you have basic familiarity with
VMware or KVM.
If you prefer to work with a professional installer, please contact your local Cisco Partner
or Cisco Stealthwatch Support.
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Process
If you are familiar with Stealthwatch, please note that we have a new process for
installing and configuring your Stealthwatch appliances. The configuration includes the
following:
l

Configuration Order: Make sure you install and configure the appliances
following the instructions in this guide and using the new order.

l

Certificates: Appliances are installed with a unique, self-signed appliance
identity certificate.

l

Central Management: You can manage your appliances from the primary
SMC/Central Manager.

For details, refer to the Release Notes.

Terminology
This guide uses the term “appliance” for any Stealthwatch product, including virtual
products such as the Stealthwatch Flow Sensor Virtual Edition (VE).
A "cluster" is your group of Stealthwatch appliances that are managed by the
Stealthwatch Management Console (SMC).
Most appliances are managed by the SMC. If an appliance is not managed by the SMC,
such as an Endpoint Concentrator, it is described as a "stand-alone appliance."

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Abbreviations
The following abbreviations may appear in this guide:

Abbreviations

Definition

DNS

Domain Name System (Service or Server)

dvPort

Distributed Virtual Port

ESX

Enterprise Server X

GB

Gigabyte

IDS

Intrusion Detection System

IPS

Intrusion Prevention System

ISO

International Standards Organization

IT

Information Technology

KVM

Kernel-based Virtual Machine

MTU

Maximum Transmission Unit

NTP

Network Time Protocol

OVF

Open Virtualization Format

SMC

Stealthwatch Management Console

TB

Terabyte

UUID

Universally Unique Identifier

VDS

vNetwork Distributed Switch

VE

Virtual Edition

VLAN

Virtual Local Area Network

VM

Virtual Machine
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Before You Begin
Before you begin, review this guide to understand the process as well as the
preparation, time, and resources you'll need to plan for the installation and
configuration.

Hardware
l

Installation: Make sure you install your appliance hardware (physical appliances)
using the Stealthwatch x210 Series Hardware Installation Guide before you
configure them using this guide.

l
l

l

Specifications: Hardware specifications are available on Cisco.com.
Supported Platforms: To view the supported hardware platforms for each
system version, refer to the Hardware Version and Support Matrix on Cisco.com.
Work Flow: See Quick Reference Workflows to review the instructions you'll
need to configure your hardware.

Virtual Appliances
You can use a VMware environment or KVM (Kernel-based Virtual Machine) for the
virtual appliance installation. It is important to review the following compatibility
information:

VMware
l
l

l

Compatibility: VMware v6.0, v6.5, or v6.7.
Environment: You can install your virtual appliances on VMware vCenter or on an
ESXi stand-alone server. Refer to 2a. Installing a Virtual Appliance using
VMware for details.
OVF Deployment: We validated VMware v6.5 using update 2 and the vSphere
flash web client. There may be issues using other clients from vSphere. You can
use the ESXi 6.5 update 2 HTML5 client, but you may encounter system timeouts.

l

VMware Upgrades: Stealthwatch VE appliances that are running on older
versions of VMware are not compatible with v6.5. If you upgrade your VMware
environment to v6.x, delete your existing Stealthwatch VE appliances and reinstall
them.
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l

Live migration (for example, with vMotion) from host to host is not supported.

l

Snapshots: Virtual machine snapshots are not supported.
Do not install VMware Tools on a Stealthwatch virtual appliance because it will
override the custom version already installed. Doing so would render the virtual
appliance inoperable and require reinstallation.

KVM
l

Compatibility: using any compatible Linux distribution.

l

KVM Host Versions: There are several methods used to install a virtual machine
on a KVM host. We tested KVM and validated performance using the following
components:

l

l

libvirt 3.0.0

l

qemu-KVM 2.8.0

l

Open vSwitch 2.6.1

l

Linux Kernel 4.4.38

Virtualization Host: For minimum requirements and best performance, review the
Virtual Edition (VE) Resource Requirements section and see the hardware
specification sheet for your appliance at Cisco.com.
The system performance is determined by the host environment. Your
performance may vary.

Downloading the VE Software
If you are installing virtual appliances, download the appliance installation file (OVF or
ISO) from the Download and License Center. For instructions, refer to the
Downloading and Licensing Stealthwatch Products Guide.

Registering and Licensing
As part of the configuration process for both hardware and virtual appliances, you will
register and license your Stealthwatch products. For instructions, refer to the
Downloading and Licensing Stealthwatch Products Guide.

TLS
Stealthwatch requires TLS v1.1 or v1.2.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Third Party Applications
Stealthwatch does not support installing third party applications on appliances.

Browsers
l

Compatible Browsers: Stealthwatch supports the latest version of Chrome,
Firefox, and Edge.

l

Microsoft Edge: There may be a file size limitation with Microsoft Edge. We do
not recommend using Microsoft Edge to install the VE OVF or ISO files.

Host Name
A unique host name is required for each appliance. We cannot configure an appliance
with the same host name as another appliance. Also, make sure each appliance host
name meets the Internet standard requirements for Internet hosts.

Domain Name
A fully qualified domain name is required for each appliance. We cannot install an
appliance with an empty domain.

NTP Server
l

Configuration: At least 1 NTP server is required for each appliance.

l

Problematic NTP: Remove the 130.126.24.53 NTP server if it is in your list of
servers. This server is known to be problematic and it is no longer supported in our
default list of NTP servers.

Time Zone
All Stealthwatch appliances use Coordinated Universal Time (UTC).
l

Virtual Host Server: Make sure your virtual host server is set to the correct time.
Make sure the time setting on the virtual host server (where you will be
installing the virtual appliances) is set to the correct time. Otherwise, the
appliances may not be able to boot up.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Hardware Resource Requirements
Use the following table to record the settings that you will need to configure
Stealthwatch appliances.

Settings

Flow
Collector

Flow

SMC

Sensor

UDP
Director

192.168.1.11*

192.168.1.4*

192.168.1.7*

192.168.1.2*

Host Name
IP Address
Subnet Mask
Gateway
DNS Server(s)
NTP Server(s)
Mail Relay

*These are default IP addresses. The Flow Collector sFlow default is
192.168.1.5. The default for the Flow Collector 5000 Series Database is
192.168.1.15.
In addition, you could also use the following settings:
Port exporting flow data (usually 2055) ________________________________
SNMP read-only community string of routers _________________________________
___________________________________
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Virtual Edition (VE) Resource Requirements
This section provides the resource requirements for the virtual appliances. Use the
tables provided in this section to record settings you will need to install and configure
the Stealthwatch VE appliances.
l

Stealthwatch Management Console (SMC)

l

Flow Collector

l

Flow Sensor

l

UDP Director

l

Endpoint Concentrator

l

Data Storage
Make sure you reserve the required resources for your system. This step is
critical for system performance.
If you choose to deploy Cisco Stealthwatch appliances without the required
resources, you assume the responsibility to closely monitor your appliance
resource utilization and increase resources as needed to ensure proper health
and function of the deployment.
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Stealthwatch Management Console VE
To determine the minimum resource allocations for the SMC VE, you should determine
the number of Flow Collectors and users expected to log in to the SMC.
Refer to the following specifications to determine your resource allocations. Also, refer
to Stealthwatch Management Console VE and Capacities for additional
information.

Flow Collectors

Concurrent
Users*

Required
Reserved
Memory

Required
Reserved
CPUs

1

2

24 GB

3

3

5

32 GB

4

5

10

32 GB

4

*Concurrent users include scheduled reports and people using the SMC client at the
same time.

Stealthwatch Management Console VE 2000
The following specifications are the default settings for the download of the SMC VE
2000, the minimum recommended, and an estimate of the hardware equivalent:

OVF or ISO

Required
Minimum
Reserved
Memory

Hardware
Equivalent*

RAM

64 GB

64 GB

128 GB

CPU

8

8

28

*These figures are based on the SMC 2010 appliance and physical (non hyper-threaded)
cores.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.

- 17 -

Virtual Edition (VE) Resource Requirements

Stealthwatch Management Console VE and Capacities
These are the Stealthwatch Management Console VE models and their capacities:

SMC VE
Model

Required
Required
Reserved Memory Reserved CPUs

SMC VE

≤ 63 GB

SMC VE 2000 ≥ 64 GB

up to 7
8 or more

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Flow Collector VE
To determine your resource allocations for the Flow Collector VE, you should determine
the flows per second expected on the network, and the number of exporters and hosts it
is expected to monitor. Refer to the following specifications to determine your resource
allocations:

Hosts

Required
Reserved
Memory

Required
Reserved
CPUs

Flow
Collector VE
Model

Up to 250

Up to
125,000

16 GB

2

FCVE

Up to
15,000

Up to 500

Up to
250,000

24 GB

3

FCVE

Up to
22,500

Up to 1000

Up to
500,000

32 GB

4

FCVE

Up to
30,000

Up to 1000

Up to
500,000

32 GB

5

FCVE

Up to
60,000

Up to 1500

Up to
750,000

64 GB

6

2000

Up to
120,000

Up to 2000

Up to
1,000,000

128 GB

7

4000

Flows per
second

Exporters

Up to
4,500

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Flow Sensor VE
Stealthwatch offers various types of Flow Sensor VEs depending upon the number of
NICs for the Flow Sensor VE.
l

Cache: The Flow Cache Size column indicates the maximum number of active
flows that the Flow Sensor can process at the same time. The cache adjusts with
the amount of reserved memory, and flows are flushed every 60 seconds. Use the
Flow Cache Size to calculate the amount of memory needed for the amount of
traffic being monitored.

l

Requirements: Your environment may require more or less resources and may
depend on a number of variables, such as average packet size, burst rate, and
other network and host conditions.

License
Type

NICs monitoring
ports
(1 Gb)

Required
Reserved
CPUs

Required
Minimum
Reserved
Memory

Estimated
Throughput

Flow Cache
Size
(maximum
number of
concurrent
flows)

FSBASE

1

1

4 GB

850 Mbps

32,766

1,850 Mbps

FSBASE

2

4

8 GB

Interfaces
configured as
PCI passthrough
(igb/ixgbe
compliant or
e1000e
compliant)

65,537

3,700 Mbps
FSBASE

4

8

16 GB

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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License
Type

NICs monitoring
ports
(1 Gb)

Required
Reserved
CPUs

Required
Minimum
Reserved
Memory

Estimated
Throughput

Flow Cache
Size
(maximum
number of
concurrent
flows)

PCI passthrough
(igb/ixgbe
compliant or
e1000e
compliant)

Optional: One or more 10G NICs may be used on the physical VM host.
These figures are based on tests with Cisco UCS C220 M4, which contains the
following:
l

Processors: 2 Intel(R) Xeon(R) CPU E5-2620 v3 @ 2.40 GHz, 2 sockets, 12 cores
per socket

l

Memory: 128 GB

l

Storage: 800 GB

l

ESXi: VMware vSphere 6.7.0

l

Monitoring Interfaces: PCI pass-through with 1 Gbps and 10 Gbps interfaces

Flow Sensor VE Network Environments
Before installing the Flow Sensor VE, make sure you know the type of network
environment you have. This guide covers all types of network environments that a Flow
Sensor VE can monitor.

Compatibility: Stealthwatch supports a VDS environment, but it does not support
VMware Distributed Resource Scheduler (VM-DRS).

Virtual Network Environments: The Flow Sensor VE monitors the following types of
virtual network environments:
l
l

A network with virtual local area network (VLAN) trunking
Discrete VLANs where one or more VLANs are prohibited from attaching packet
monitoring devices (for example, due to local policy)

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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l

Private VLANs

l

Hypervisor hosts rather than VLANs

Integration: For integration information, review Stealthwatch Flow Sensor.

Flow Sensor VE Traffic
The Flow Sensor will process traffic with the following Ethertypes:

Ethertype

Protocol

0x8000

Normal IPv4

0x86dd

Normal IPv6

0x8909

SXP

0x8100

VLAN

0x88a8
0x9100
0x9200

VLAN QnQ

0x9300
0x8847

MLPS unicast

0x8848

MLPS multicast

The Flow Sensor saves the top-level MPLS label or VLAN ID and exports it. It
bypasses the other labels when it is processing packets.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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UDP Director VE
The UDP Director VE requires that the virtual machine meets the following
specifications:
l

4 GB RAM

l

Thick or Thin Provisioning: We recommend thick provisioning although thin
provisioning can be used if disk space is limited.

Endpoint Concentrator
These are the requirements for the Endpoint Concentrator 1000:

Reserved CPU Reserved Memory Maximum FPS Rate
2

8 GB

20,000

The capacity of your Flow Collector should be taken into consideration in
determining the number of Endpoint Concentrators needed for your
deployment.
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Data Storage
The appliance data storage expands automatically when the appliance reboots. Also,
you may want to expand the appliance resource allocations to improve performance.
Use the following information to allocate storage for each appliance.
Make sure you reserve the required resources for your system. This step is
critical for system performance.
If you choose to deploy Cisco Stealthwatch appliances without the required
resources, you assume the responsibility to closely monitor your appliance
resource utilization and increase resources as needed to ensure proper health
and function of the deployment.
l

Expansion Calculation: The virtual appliance uses approximately 75% of the
server for data storage, leaving 25% for the operating system and cache.
Therefore, always expand the data storage to 40% more than the desired amount.

l

FPS Calculation: Allocate a minimum of 1 GB of data storage for every 1,000
flows per second (FPS) your system averages daily multiplied by the number of
days you want to store the flows. For example, if your system averages 2,000 FPS
and you want to store flows for 30 days, allocate a minimum of 60 GB (2 X 30) of
data storage space.

l

Syslog: If the External Event processing (syslog) feature is used, more memory
and processing resources are required.

l

Data Storage: Use the following table to determine the data storage for each
appliance.

l

Restart: If you increase the virtual machine memory using another method on your
Hypervisor host, restart the appliance after you have saved your changes.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Stealthwatch VE Model

Required
Minimum
Data Storage

Maximum
Addressable
Storage/
Hardware
Equivalent

Stealthwatch Management Console VE

125 GB

5.6 TB

Stealthwatch Management Console VE
2000

200 GB

7.2 TB

Flow Collector NetFlow VE

200 GB

1 TB

Flow Collector NetFlow VE 2000

600 GB

2 TB

Flow Collector NetFlow VE 4000

1.5 TB

7.2 TB

Flow Collector sFlow VE

100 GB

1 TB

Flow Collector sFlow VE 2000

600 GB

2 TB

Flow Collector sFlow VE 4000

1.5 TB

7.2 TB

Flow Sensor

60 GB

UDP Director

60 GB
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Access Information
Use the following charts to review and record the information you will need for console
and admin access. We've included the default information that is used when you first
configure the system.

Hypervisor Server
Use the following chart to record your Hypervisor Server information.

Setting

Hypervisor Server

Login User Name
Login Password
IP Address
Netmask IP Address
Gateway IP Address

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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SMC VE
Console Access
Console Setting

SMC VE

Login User Name
Login Password
IP Address

Netmask IP Address

Gateway IP Address

192.168.1.11

255.255.255.0

192.168.1.1

Admin Access
Admin Setting
IP Address

SMC VE
192.168.1.11

Host Name
Network Domain Name
NTP Server IP Address(es)
DNS Server IP Address(es)

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Flow Collector VE
Console Access
Console Setting

Flow Collector VE

Login User Name
Login Password
IP Address

Netmask IP Address

Gateway IP Address

192.168.1.4

255.255.255.0

192.168.1.1

Admin Access
Admin Setting
IP Address

Flow Collector VE
192.168.1.4

Host Name
Network Domain Name
NTP Server IP Address(es)
DNS Server IP Address(es)
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Flow Sensor VE
Console Access
Console Setting

Flow Sensor VE

Login User Name
Login Password
IP Address

Netmask IP Address

Gateway IP Address

192.168.1.6

255.255.255.0

192.168.1.1

Admin Access
Admin Setting
IP Address

Flow Sensor VE
192.168.1.6

Host Name
Network Domain Name
NTP Server IP Address(es)
DNS Server IP Address(es)
The Flow Sensor VE requires the following additional information:
IP addresses and listening port numbers (default = 2055) for each NetFlow collector
and/or UDP Director™ that will be receiving data from the Flow Sensor VE
_______________________________________________________________
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UDP Director VE
Console Access
Console Setting

UDP Director VE

Login User Name
Login Password
IP Address

Netmask IP Address

Gateway IP Address

192.168.1.2

255.255.255.0

192.168.1.1

Admin Access
Admin Setting
IP Address

UDP Director VE
192.168.1.2

Host Name
Network Domain Name
NTP Server IP Address(es)
DNS Server IP Address(es)
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Endpoint Concentrator
Console Access
Console Setting

Endpoint Concentrator

Login User Name
Login Password
IP Address

Netmask IP Address

Gateway IP Address

192.168.1.x

255.255.255.0

192.168.1.1

Admin Access
Admin Setting
IP Address

Endpoint Concentrator
192.168.1.x

Host Name
Network Domain Name
NTP Server IP Address(es)
DNS Server IP Address(es)
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Quick Reference Workflows
This guide provides the information you need to install and configure your Stealthwatch
system. You may not have all the appliances described in this guide. We've provided
links so you can quickly find the information you need or skip anything that does not
apply to your setup.

Stealthwatch Hardware
Use the following workflow to configure your Stealthwatch hardware.

1. Use the Stealthwatch x210 Series Hardware Installation Guide to install your
Stealthwatch physical appliances.

2. Use this guide to configure your appliances.
l

l

Review the Introduction section and Hardware Resource Requirements
to plan for the configuration.
You can skip the Virtual Edition (VE) installation instructions (1. Installing a
Virtual Appliance: Configuring your Firewall and Ports through 3.
Configuring the IP Addresses).

3. Go to 4. Configuring Your Appliances, and follow the instructions to the end of
this guide.

Stealthwatch Virtual Edition
Use the following workflow to install and configure your virtual appliances.

1. Review the Introduction section and Virtual Edition (VE) Resource
Requirements to plan for the VE installation and configuration.
2. Install your virtual appliances using the following instructions in this guide:
l

l

l

1. Installing a Virtual Appliance: Configuring your Firewall and Ports
2a. Installing a Virtual Appliance using VMware or 2b. Installing a
Virtual Appliance on a KVM Host (ISO).
3. Configuring the IP Addresses

3. Continue with 4. Configuring Your Appliances, and follow the instructions to
the end of this guide.
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1. Installing a Virtual Appliance: Configuring
your Firewall and Ports
Overview
Before you can install your virtual appliance, complete the following procedures to
prepare your network:

1. Placing the Appliances
2. Configuring Your Firewall for Communications
3. Stealthwatch Flow Sensor

Placing the Appliances
Review the placement information for each appliance you are installing.
l

Stealthwatch Management Console (SMC)

l

Flow Collector

l

Flow Sensor

l

UDP Director

Stealthwatch Management Console
As the management device, install the Stealthwatch Management Console at a location
on your network that is accessible to all the devices sending data to it.
If you have a failover pair of Stealthwatch Management Consoles, we recommend
installing the primary and the secondary consoles in separate physical locations. This
strategy will enhance a disaster recovery effort should it become necessary.

Stealthwatch Flow Collector
As collection and monitoring devices, the Stealthwatch Flow Collector should be
installed at a location on your network that is accessible to the NetFlow or sFlow devices
sending the data to a Flow Collector, as well as any devices you plan to use to access
the management interface.
When you place a Flow Collector outside a firewall, we recommend that you turn off the
setting Accept traffic from any exporter.
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Stealthwatch Flow Sensor
As a passive monitoring device, the Stealthwatch Flow Sensor can sit at multiple points
on your network to observe and record IP activity, thereby protecting network integrity
and detecting security breaches. The Flow Sensor features integrated web-based
management systems that facilitate either centralized or remote management and
administration.
The Flow Sensor VE appliance is most effective when placed at critical segments of your
corporate network as follows:
l

Inside your firewall to monitor traffic and determine if a firewall breach has
occurred

l

Outside your firewall, monitoring traffic flow to analyze who is threatening your
firewall

l

At sensitive segments of your network, offering protection from disgruntled
employees or hackers with root access

l

At remote office locations that constitute vulnerable network extensions

l

On your business network for protocol use management (for example, on
your transaction services subnet to determine if a hacker is running Telnet or FTP
and compromising your customers' financial data)

Important Considerations for Integration
The Stealthwatch Flow Sensor VE is versatile enough to integrate with a wide variety of
network topologies, technologies, and components. Before you install a Flow Sensor
VE, you must make several decisions about your network and how you want to monitor
it. It is important to review the following:
l
l

l

Analyze your network's topology and your specific monitoring needs.
Connect a Flow Sensor so that it receives network transmissions to and from the
monitored network, and, if desired, receives interior network transmissions as
well.
For optimum performance when using the Flow Sensor to monitor physical
network traffic, configure your Flow Sensor VE with direct access to the underlying
physical host’s NICs (such as using an igb or e1000e compliant PCI pass-through).

The following sections explain how to integrate a Stealthwatch Flow Sensor VE
appliance into your network using the following Ethernet network devices:
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l

TAPs

l

SPAN Ports

While not all network configurations can be discussed here, the examples may help you
determine the best setup for your monitoring needs. These examples provide physical
network scenarios, and the virtual host can be configured in a similar way.

TAPs
When a Test Access Port (TAP) is placed in line with a network connection, it repeats
the connection on a separate port or ports. For example, an Ethernet TAP placed in line
with an Ethernet cable will repeat each direction of transmission on separate ports.
Therefore, use of a TAP is the most reliable way to use the Flow Sensor. The type of
TAP you use depends on your network.

Configuration: For important configuration information, see Flow Sensor in the 4.
Configuring Your Appliances.
This section explains the following ways to use TAPs:
l

Using Electrical TAPs

l

Using Optical TAPs

l

Using TAPs Outside Your Firewall

l

Placing the Flow Sensor VE Inside Your Firewall

In a network using TAPs, the Flow Sensor VE can capture performance monitoring data
only if it is connected to an aggregating TAP that is capturing both inbound and
outbound traffic. If the Flow Sensor VE is connected to a unidirectional TAP that is
capturing only one direction of traffic on each port, then the Flow Sensor VE will not
capture performance monitoring data.

Using Electrical TAPs
The following illustration shows the Stealthwatch Flow Sensor VE connected to an
Ethernet electrical TAP. To achieve this configuration, connect the two TAP ports to the
Flow Sensor VE Monitor Ports 1 and 2, as shown.
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Using Optical TAPs
Two splitters are required for fiber-optic–based systems. You can place a fiber-optic
cable splitter in line with each direction of transmission and use it to repeat the optical
signal for one direction of transmission.
The following illustration shows the Flow Sensor connected to a fiber-optic–based
network. To achieve this configuration, connect the outputs of the optical splitters to the
Flow Sensor VE Monitor Ports 1 and 2, as shown.

If the connection between the monitored networks is an optical connection, then the
Stealthwatch Flow Sensor VE appliance is connected to two optical splitters. The
management port is connected to either the switch of the monitored network or to
another switch or hub.

Using TAPs Outside Your Firewall
To have the Flow Sensor VE monitor traffic between your firewall and other networks,
connect the Stealthwatch management port to a switch or port outside of the firewall.
We strongly recommend that you use a TAP for this connection so that failure of the
device does not bring down your entire network.
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The following illustration shows an example of this configuration using an Ethernet
electrical TAP. The management port must be connected to the switch or hub of the
monitored network. This setup is similar to the setup that monitors traffic to and from
your network.

If your firewall is performing network address translation (NAT), you can observe only
the addresses that are on the firewall.

Placing the Flow Sensor VE Inside Your Firewall
To monitor traffic between internal networks and a firewall, the Flow Sensor VE must be
able to access all traffic between the firewall and the internal networks. You can
accomplish this by configuring a mirror port that mirrors the connection to the firewall on
the main switch. Make sure that the Flow Sensor VE Monitor Port 1 is connected to the
mirror port, as shown in the following illustration:

To monitor traffic inside your firewall by using a TAP, insert the TAP or optical splitter
between your firewall and the main switch or hub. A TAP configuration is shown below.
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An optical splitter configuration is shown below.

SPAN Ports
You can also connect the Flow Sensor VE to a switch. However, because a switch does
not repeat all traffic on each port, the Flow Sensor VE will not perform properly unless
the switch can repeat packets transmitted to and from one or more switch ports. This
type of switch port is sometimes called a mirror port or Switch Port Analyzer (SPAN).
The following illustration shows how you can achieve this configuration by connecting
your network to the Stealthwatch Flow Sensor VE through the management port.
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In this configuration, you must configure a switch port (also called a mirror port), to
repeat all traffic to and from the host of interest to the mirror port. The Flow Sensor VE
Monitor Port 1 must be connected to this mirror port. This allows the Flow Sensor to
monitor traffic to and from the network of interest and to other networks. In this
instance, a network may be made up of some or all of the hosts connected to the switch.
A common way of configuring networks on a switch is to zone them into virtual local area
networks (VLANs), which are logical rather that physical connections of hosts. If the
mirror port is configured to mirror all ports on a VLAN or switch, the Flow Sensor VE can
monitor all traffic to, from, and within the network of interest, as well as other networks.
l

l

Configuration: For important configuration information, see Flow Sensor in the
4. Configuring Your Appliances section.
Documentation: In all cases, make sure you consult your switch manufacturer's
documentation to determine how to configure the switch mirror port and what
traffic will be repeated to the mirror port.

Stealthwatch UDP Director
The only requirement for the placement of the Stealthwatch UDP Director is that it has
an unobstructed communication path to the rest of your Stealthwatch appliances.
If you are deploying the UDP Director in an environment where Cisco's ACI is
being utilized and Unicast Reverse Path Forwarding (uRPF) or Limit IP
learning to subnet is enabled, the local network may block the forwarded
traffic leaving the UDP Director. You need to spoof the UDP traffic as part of the
forwarding rules so tools collecting the log data are able to know the original
source of traffic.
To ensure a successful operation of the UDP Director in this case, deploy your
UDP Director on a portion of your network where you can disable uRPF or Limit
IP learning to subnet (typically internally). You can place the UDP Director in
an L3 out (no IP learning). If on 4.0+, you can disable endpoint learning on a per
VRF basis.
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Configuring Your Firewall for Communications
In order for the appliances to communicate properly, you should configure the network
so that firewalls or access control lists do not block the required connections. Use the
information provided in this section to configure your network so that the appliances can
communicate through the network.

Open Ports
Stealthwatch Management Console (SMC), Flow Collector, Flow Sensor, and
UDP Director
Consult with your network administrator to ensure that the following ports are open and
have unrestricted access:
l

TCP 22

l

TCP 25

l

TCP 389

l

TCP 443

l

TCP 2393

l

TCP 5222

l

UDP 53

l

UDP 123

l

UDP 161

l

UDP 162

l

UDP 389

l

UDP 514

l

UDP 2055

l

UDP 6343

Endpoint Concentrator
Use the port information in this section to configure your network so the appliances can
communicate on the network:
l

TCP 22

l

TCP 443

l

UDP 53
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l

UDP 123

l

UDP 161

l

UDP 162

l

UDP 514

l

UDP 2055

l

UDP 3514

Communication Ports and Protocols
The following table shows how the ports are used in Stealthwatch:

From (Client)

To (Server)

Port

Protocol

Admin User PC

All appliances

TCP/443

HTTPS

All appliances

Network time source

UDP/123

NTP

Active Directory

SMC

TCP/389,
UDP/389

LDAP

AnyConnect

Endpoint Concentrator

UDP/2055

NetFlow

Cisco ISE

SMC

TCP/443

HTTPS

Cisco ISE

SMC

TCP/5222

XMPP

Endpoint
Concentrator

Flow Collector

UDP/2055

NetFlow

External log
sources

SMC

UDP/514

SYSLOG

Flow Collector

SMC

TCP/443

HTTPS

UDP Director

Flow Collector - sFlow

UDP/6343

sFlow

UDP Director

Flow Collector - NetFlow

UDP/2055*

NetFlow

UDP Director

3rd Party event management
systems

UDP/514

SYSLOG
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From (Client)

To (Server)

Port

Protocol

Flow Sensor

SMC

TCP/443

HTTPS

Flow Sensor

Flow Collector - NetFlow

UDP/2055

NetFlow

Identity

SMC

TCP/2393

SSL

NetFlow Exporters

Flow Collector - NetFlow

UDP/2055*

NetFlow

sFlow Exporters

Flow Collector - sFlow

UDP/6343*

sFlow

SMC

Cisco ISE

TCP/443

HTTPS

SMC

Cisco ISE

TCP/5222

XMPP

SMC

DNS

UDP/53

DNS

SMC

Flow Collector

TCP/443

HTTPS

SMC

Flow Sensor

TCP/443

HTTPS

SMC

Identity

TCP/2393

SSL

SMC

Flow Exporters

UDP/161

SNMP

SMC

Endpoint Concentrator

UDP/2055

netflow

SMC

LDAP

TCP/636

TLS

User PC

SMC

TCP/443

HTTPS

*This is the default NetFlow port, but any UDP port could be configured on
the exporter.
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Optional Communication Ports
The following table is for optional configurations determined by your network needs:

From (Client) To (Server)

Port

Protocol

All appliances

User PC

TCP/22

SSH

SMC

3rd Party event management systems UDP/162

SNMP-trap

SMC

3rd Party event management systems UDP/514

SYSLOG

SMC

Email gateway

TCP/25

SMTP

SMC

Threat Intelligence Feed

TCP/443

SSL

User PC

All appliances

TCP/22

SSH
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The following diagram shows the various connections used by Stealthwatch. Some of
these ports are optional.
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Go to the section that is applicable to your virtual appliance
installation: VMware vSphere Client or KVM.
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2a. Installing a Virtual Appliance using
VMware
Overview
This procedure describes how to install your virtual appliances using a VMware
environment.
To install your virtual appliances using KVM, go to 2b. Installing a Virtual
Appliance on a KVM Host (ISO).

Before You Begin
Before you begin the installation, complete the following preparation procedures:

1. Review your VMware host environment. Review which method you will use to
install your virtual appliances.
l

l

VMware vCenter: Use Installing a Virtual Appliance Using vCenter
(OVF).
VMware ESXi Stand-Alone Server: Use Installing a Virtual Appliance
on an ESXi Stand-Alone Server (ISO).

2. Download the appliance files from the Download and License Center. See the
Downloading and Licensing Guide for instructions.
l

VMware vCenter: Download the OVF file.

l

VMware ESXi Stand-Alone Server: Download the ISO file.

3. Review the compatibility information in the Before You Begin: Virtual Appliances
section.
4. Configure Your Firewall for Communications.
5. Review the Resource Requirements section to determine the proper allocations
for the appliance. You can use a resource pool or alternative method to allocate
resources.

6. Confirm the time set on the hypervisor host in your VMware environment (where
you will be installing the virtual appliance) shows the correct time. Otherwise, the
virtual appliances may not be able to boot up.
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Do not install an untrusted physical or virtual machine on the same physical
cluster/system as your Stealthwatch appliances.
Do not install VMware Tools on a Stealthwatch virtual appliance because it will
override the custom version already installed. Doing so would render the virtual
appliance inoperable and require reinstallation.

Installing a Virtual Appliance Using vCenter (OVF)
If you have VMware vCenter (or similar), use the following instructions to install a virtual
appliance using the OVF.

Process Overview
Installing a virtual appliance involves completing the following procedures, which are
covered in this chapter:

1. Logging in to the VMware Client
2. Configuring the Flow Sensor to Monitor Traffic
3. Installing the Virtual Appliance
4. Defining Additional Monitoring Ports (Flow Sensors only)

1. Logging in to the VMware Client
To install the virtual appliance, log in to the VMware Client or Web Client first.
Whether you are using the VMware Client or Web Client interface, some of the
graphics and commands may vary from the information shown here. Please see
your VMware guide for details related to the software.

1. Launch the VMware Client software. The Login dialog opens.
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2. Enter the IP address (or Fully Qualified Domain Name) of your VMware
Environment. Enter your login credentials.

3. Click Login. The Home page opens.
4. If the appliance is a Flow Sensor, go to 2. Configuring the Flow Sensor to
Monitor Traffic.
If the appliance is not a Flow Sensor, go to 3. Installing the Virtual Appliance.

2. Configuring the Flow Sensor to Monitor Traffic
The Flow Sensor VE has the ability to provide visibility into VMware environments,
generating flow data for areas that are not flow-enabled. As a virtual appliance
installed inside each hypervisor host, the Flow Sensor VE passively captures Ethernet
frames from the host vSwitch, and it observes and creates flow records containing
valuable session statistics that pertain to conversational pairs, bit rates, and packet
rates. For details, see Stealthwatch Flow Sensor.
Use the following instructions to configure the Flow Sensor VE to monitor traffic on a
vSwitch as follows:
l

Monitoring a vSwitch with Multiple Hosts

l

Monitoring a vSwitch with a Single Host

Monitoring a vSwitch with Multiple Hosts
Use the instructions in this section to use the Flow Sensor VE to monitor traffic on a
Distributed vSwitch that spans multiple VM hosts or clusters.
This section applies only to VDS networks. If your network is in a non-VDS environment,
go to Monitoring a vSwitch with a Single Host

Configuration Requirements
This configuration has the following requirements:
l

Distributed Virtual Port (dvPort): Add a dvPort group with the correct VLAN
settings for each VDS that the Flow Sensor VE will monitor. If the Flow Sensor VE
monitors both VLAN and non-VLAN traffic on the network, you need to create two
dvPort groups, one for each type.

l

VLAN Identifier: If your environment uses a VLAN (other than VLAN trunking or a
private VLAN), you will need the VLAN identifier to complete this procedure.
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l

Promiscuous Mode: enabled

l

Promiscuous Port: configured to the vSwitch

Complete the following steps to configure the network using a VDS:

1. In the View menu, select Inventory > Networking to display the Networking tree
on the left.

On the Web client, click Networking in the Inventory Tree list:

2. In the Networking tree, select the VDS.

3. In the right pane, click Create a new port group.
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The Create dvPort Group wizard opens.

The Web Client has two dialogs for the configuration: Select name and location and
Configure settings.

4. In the Name field, type the name you want to use to identify this dvPort group.
5. In the Number of Ports field, type the number of Flow Sensor VEs in your cluster
of hosts.

6. Click the VLAN type drop-down.
l
l

If your environment doesn't use a VLAN, select None.
If your environment uses a VLAN, select the VLAN type. Use the following
table to complete the configuration for your selection.
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VLAN Type

Detail

VLAN

In the VLAN ID field, enter the number
(between 1 and 4094) that matches the
identifier.

VLAN Trunking

In the VLAN trunk range field, enter 04094 to monitor all VLAN traffic.

Private VLAN

Select Promiscuous from the drop-down
list.

7. Click Next.

8. Review the settings on the summary page. Click Finish. The new dvPort group
appears in the Networking tree.
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9. Right-click the new dvPort group. Select Edit Settings.

10. In the left pane, select Security.

11. In the right pane in the Promiscuous Mode drop-down list, select Accept.
12. Click OK to close the dialog.
13. Does the Flow Sensor VE monitor both VLAN and non-VLAN network traffic?
l

If yes, repeat the steps in this section Monitoring a vSwitch with Multiple

Hosts
l

If no, continue to the next step.

14. Is there another VDS in the VMware environment that the Flow Sensor VE will
monitor?
l

If yes, repeat the steps in this section Monitoring a vSwitch with Multiple
Hosts for the next VDS.
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l

If no, go to 3. Installing the Virtual Appliance.

Monitoring a vSwitch with a Single Host
Use the instructions in this section to use the Flow Sensor VE to monitor traffic on a
vSwitch with a single host.
This section applies only to non-VDS networks. If your network uses a VDS, go
to Monitoring a vSwitch with Multiple Hosts.
This configuration has the following requirements:
l

Promiscuous Port Group: Add a promiscuous port group for each virtual switch
that the Flow Sensor VE will be monitoring.

l

Promiscuous Mode: enabled

l

Promiscuous Port: configured to the vSwitch

Complete the following steps to configure the network using a non-VDS environment.

1. Add a Port Group
2. Set the Port Group to Promiscuous Mode

Add a Port Group
To add a port group, complete the following steps:

1. In the Inventory tree, select the hypervisor host environment, and then click the
Configuration tab.
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The Configuration page opens.

2. In the Hardware pane, click Networking.
The Configuration tab displays the list of installed virtual switches.

3. Scroll through the list to locate the virtual switch that the Flow Sensor VE will be
monitoring, and then click the Properties link. The Properties dialog for that
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virtual switch opens.

4. Click Add. The Add Network Wizard opens to the Connection Type page.

5. Under Connection Types, select Virtual Machine. Click Next. The Connection
Settings page opens.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.

- 55 -

2a. Installing a Virtual Appliance using VMware

6. Optional: Change the Network Label for the port group.
7. Click the VLAN ID drop-down list and select All (4095) to allow the Flow Sensor
VE to see traffic on all VLANs through this port group.

8. Click Next. The Summary page opens, showing the port group you added.

9. Click Finish to return to the virtual switch Properties dialog, which shows the new
port group.
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10. Continue with the next section.

Set the Port Group to Promiscuous Mode
To set the port group to Promiscuous Mode, complete the following steps:

1. On the virtual switch Properties dialog, select the port group you just added and
click Edit.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.

- 57 -

2a. Installing a Virtual Appliance using VMware

The Properties dialog for the port group opens.

2. Click the Security tab to display the Policy Exceptions options.

3. Click the Promiscuous Mode checkbox. Select Accept from the drop-down list.
4. Click OK to return to the virtual switch Properties dialog.
5. Click Close to dismiss the virtual switch Properties dialog. The new port group
appears on the Networking page of the Configuration tab.
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6. Will the Flow Sensor VE be monitoring another virtual switch in this VMware
environment?
l

l

If yes, go back to 2. Configuring the Flow Sensor to Monitor Traffic, and
repeat all the steps for the next virtual switch.
If no, go to 3. Installing the Virtual Appliance.
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3. Installing the Virtual Appliance
Use the following instructions to install a virtual appliance on your hypervisor host and
define the virtual appliance management and monitoring ports.
Whether you are using the VMware Client or Web Client interface, some of the
graphics and commands may vary from the information shown here. Please see
your VMware guide for details related to the software.

1. Locate the virtual appliance software file (OVF.TGZ) that you downloaded from the
Download and License Center..

2. Unzip or open the file, and then untar it.
l
l

To untar the file, select all the files in the folder and extract them.
Unzipping TGZ file is a two-step process, and the steps may vary depending
on the software you use.

3. On the VMware client menu, click File > Deploy OVF Template.
Web Client: Right-click the host. Select Deploy OVF Template.

The Web client OVF template wizard may vary from the images and instructions
shown here, but the steps are similar. One example is the Web client uses
Source Location instead of Source. The image below shows the steps on the
left side for a OVF template ready to deploy:
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The Deploy OVF Template wizard opens.
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4. Click Browse. Navigate to select the virtual appliance OVF file.
5. Click Next to display the OVF Template Details page.
Web Client: The 1.b. Review details page opens.

6. Click Next. Review the End User License Agreement.
Web Client: 1c. Accept EULAs.
7. After reviewing the information, click Accept. Click Next.
Web Client: 2a. The Name and Location page opens.
8. Optional: Change the name and location for the virtual appliance. This should be a
unique name and will display in the Inventory tree. Click Next.
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9. On the Storage page, select where you want to store the data files.
Review Resource Requirements to allocate sufficient resources. Click Next.

Review Resource Requirements to allocate sufficient resources. This step is
critical for system performance.
If you choose to deploy Cisco Stealthwatch appliances without the required
resources, you assume the responsibility to closely monitor your appliance
resource utilization and increase resources as needed to ensure proper health
and function of the deployment.
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10. On the Disk Format page, select Thick Provision Lazy Zeroed or Thick
Provision Eager Zeroed. Click Next.
l

Use the Thin Provision format only if your disk space is limited.

l

For more information, see your VMware documentation.

11. On the Network Mapping page, select the networks for the virtual appliance. Click
Next.
Web Client: The 2c. Setup Networks page opens.
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12. On the Ready to Complete page, review the summary of settings. If they are
correct, click Finish.

13. The deployment dialog box opens.

14. When the deployment is completed, click Close The installed virtual appliance
appears in the Inventory tree.
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15. Flow Sensors: If the appliance is a Flow Sensor and will be monitoring more than
one virtual switch in the VMware environment, or more than one VDS in a cluster,
continue with the next section 4. Defining Additional Monitoring Ports (Flow
Sensors only).

16. Repeat all of the procedures in 2a. Installing a Virtual Appliance using VMware
for the next virtual appliance in your system.
If you have installed all virtual appliances in your system, go to 3. Configuring
the IP Addresses.

4. Defining Additional Monitoring Ports (Flow Sensors only)
This procedure is required if the Flow Sensor VE will be monitoring more than one virtual
switch in a VMware environment or more than one VDS in a cluster. If this is not the
monitoring configuration for your Flow Sensor, go to 3. Configuring the
IP Addresses.
To add Flow Sensor VE monitoring ports, complete the following steps:

1. In the Inventory tree, right-click the Flow Sensor VE, and then select Edit
Settings.
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The Flow Sensor VE Virtual Machine Properties dialog opens.

2. Click Add. The Add Hardware dialog opens to the Device Type page.
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3. Select Ethernet Adapter in the list of device types, and then click Next. The
Network Type page opens.

4. Do the following:
l
l

In the Adapter Type section, select VMXNET 3.
In the Network Connection section, select an unassigned promiscuous
port group.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.

- 68 -

2a. Installing a Virtual Appliance using VMware

l

In the Device Status section, make sure that the Connect at power on
check box is selected.

5. Click Next to see a summary.

6. After reviewing the settings, click Finish.
7. The Flow Sensor VE Virtual Machine Properties dialog opens, showing the newly
defined monitor port.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.

- 69 -

2a. Installing a Virtual Appliance using VMware

8. If the Flow Sensor VE will be monitoring another virtual switch in the VMware
environment, or another VDS in a cluster, repeat this procedure for the next virutal
switch.

9. To finish this configuration, click OK. Go to 3. Configuring the IP Addresses
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Installing a Virtual Appliance on an ESXi Stand-Alone
Server (ISO)
If you have an ESXi stand-alone host server, use the following instructions to install a
virtual appliance using the ISO from from the Download and License Center..

Process Overview
Installing a virtual appliance involves completing the following procedures, which are
covered in this chapter:

1. Logging in to the VMware Web Client
2. Booting from the ISO
Flow Sensors: If the appliance is a Flow Sensor, review Stealthwatch Flow
Sensor to understand the additional configuration steps required.

1. Logging in to the VMware Web Client
Whether you are using the VMware Client or Web Client interface, some of the
graphics and commands may vary from the information shown here. Please see
your VMware guide for details related to the software.

1. Log in to the VMware Web Client.
2. Click Create/Register a Virtual Machine. The New Virtual Machine guide opens.
3. Select Creation Type: Select Create a New Virtual Machine. Click Next.

4. Select a Name and Guest OS: Enter or select the following:
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l

Name: Enter a name for the appliance so you can identify it easily.

l

Compatibility: Select the version you are using.

l

Guest OS family: Linux

l

Guest OS version: Debian GNU/Linux

5. Click Next.
6. Select Storage: Select an accessible data store. Review Resource
Requirements to confirm you have enough space.

Review Resource Requirements to allocate sufficient resources. This step is
critical for system performance.
If you choose to deploy Cisco Stealthwatch appliances without the required
resources, you assume the responsibility to closely monitor your appliance
resource utilization and increase resources as needed to ensure proper health
and function of the deployment.
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7. Customize Settings: Enter or select your appliance requirements (refer to
Resource Requirements for details).
Make sure you select the following:
l

SCSI Controller: LSI Logic Parallel

l

Network Adapter: Confirm the management address for the appliance.
If the appliance is a Flow Sensor, you can click Add Network Adapter to
add another management or sensing interface. Refer to Stealthwatch Flow
Sensor for details.

8. Click the arrow next to Network Adapter.
9. For the Adapter Type, select VMXnet3.
10. Click Next.
11. Review your configuration settings and confirm they are correct.
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12. Click Finish. A virtual machine container is created.

2. Booting from the ISO
1. Open the VMware console.
2. Connect the ISO to the new virtual machine. Refer to the VMware documentation
for details.

3. Boot the virtual machine from the ISO. It runs the installer and reboots
automatically.

4. Once the installation and reboot are completed, you will see the login prompt.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.

- 74 -

2a. Installing a Virtual Appliance using VMware

5. Disconnect the ISO from the virtual machine.
6. Repeat all of the procedures in Installing a Virtual Appliance on an ESXi StandAlone Server (ISO) for the next virtual appliance.
7. Flow Sensors: If the appliance is a Flow Sensor, review Stealthwatch Flow
Sensor and finish the setup using the previous sections of this manual:
l

2. Configuring the Flow Sensor to Monitor Traffic (use Monitoring a
vSwitch with a Single Host)

l

If the Flow Sensor will be monitoring more than one virtual switch in the
VMware environment, or more than one VDS in a cluster, go to 4. Defining
Additional Monitoring Ports (Flow Sensors only).

8. If you have installed all virtual appliances, go to 3. Configuring the
IP Addresses.
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2b. Installing a Virtual Appliance on a KVM
Host (ISO)
Overview
This procedure describes how to install your virtual appliances using KVM and Virtual
Machine Manager.
To install your virtual appliances using VMware, go to 2a. Installing a Virtual
Appliance using VMware .

Before You Begin
Before you begin the installation, complete the following preparation procedures:

1. Download the ISO file from the Download and License Center. and copy the image
to a folder on the KVM host. In the example given below, the folder is
var/lib/libvirt/image. See the Downloading and Licensing Guide for instructions.

2. Review the compatibility information in the Before You Begin: Virtual Appliances
section.
3. Configure Your Firewall for Communications.
4. Review the Resource Requirements section to determine the proper allocations
for the appliance.

5. Confirm the time set on the host server (where you will be installing the virtual
appliance) shows the correct time. Otherwise, the virtual appliances may not be
able to boot up.
Do not install an untrusted physical or virtual machine on the same physical
cluster/system as your Stealthwatch appliances.

Process Overview
Installing a virtual appliance involves completing the following procedures, which are
covered in this chapter:
l
l

1. Installing a Virtual Appliance on a KVM Host
2. Adding NIC and Promiscuous Port Monitoring on an Open vSwitch (Flow
Sensors Only)
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1. Installing a Virtual Appliance on a KVM Host
There are several methods to install a virtual machine on a KVM host using a ISO file.
The following steps give one example for installing a virtual Stealthwatch Management
Console (SMC) through a GUI tool called Virtual Machine Manager running on a Ubuntu
box. You can use any compatible Linux distribution. For compatibility details, see the
Compatibility section of the Introduction.

Monitoring Traffic: The Flow Sensor VE has the ability to provide visibility into KVM
environments, generating flow data for areas that are not flow-enabled. As a virtual
appliance installed inside each KVM host, the Flow Sensor VE passively captures
Ethernet frames from traffic it observes and creates flow records containing valuable
session statistics that pertain to conversational pairs, bit rates, and packet rates. For
details, see 1. Installing a Virtual Appliance: Configuring your Firewall and
Ports: Integrating the Flow Sensor VE into your network.

Configuration Requirements
This configuration has the following requirements:
l

Promiscuous Mode: enabled

l

Promiscuous Port: configured to an open vSwitch

To install a virtual appliance, and enable the Flow Sensor VE to monitor traffic, complete
the following steps:

1. Use Virtual Machine Manager to connect to the KVM Host and configure the
appliance as specified in the following steps.

2. Click File > New Virtual Machine.

3. Select Local install media (ISO image or CDROM). Click Forward.
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4. Click Use ISO image.
5. Click Browse. Select the appliance image.

6. Select the ISO file. Click Choose Volume.
Confirm the ISO file is accessible by the KVM Host.
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7. Under Choose an operating system type and version, select Linux from the
OS type drop-down list.

8. From the Version drop-down list, select Debian Jessie. Click Forward.

9. Increase the Memory (RAM) and CPUs to the amount shown in the Virtual Edition
(VE) Resource Requirements section.
Review Resource Requirements to allocate sufficient resources. This step is
critical for system performance.
If you choose to deploy Cisco Stealthwatch appliances without the required
resources, you assume the responsibility to closely monitor your appliance
resource utilization and increase resources as needed to ensure proper health
and function of the deployment.
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10. Select Create a disk image for the virtual machine.
11. Enter the data storage amount shown for the appliance in Virtual Edition (VE)
Resource Requirements section. Click Forward.

Review Resource Requirements to allocate sufficient resources. This step is
critical for system performance.
If you choose to deploy Cisco Stealthwatch appliances without the required
resources, you assume the responsibility to closely monitor your appliance
resource utilization and increase resources as needed to ensure proper health
and function of the deployment.
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12. Assign a Name for the virtual machine. This will be the display name, so use a
name that will help you find it later.

13. Check the Customize configuration before install check box.
14. In the Network selection drop-down box, select the applicable network and port
group for installation.

15. Click Finish. The configuration menu opens.
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16. In the navigation pane, select NIC.
17. Under Virtual Network Interface, select e1000 in the Device model drop-down
box. Click Apply.
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18. Click VirtIO Disk 1.
19. In the Advanced Options drop-down list, select SCSI in the Disk bus drop-down
box. Click Apply.
20. Do you need to add additional NICS for monitoring ports on the Flow Sensor VE?
l

l

If yes, go to 2. Adding NIC and Promiscuous Port Monitoring on an
Open vSwitch (Flow Sensors Only).
If no, go to the next step.

21. Click Begin Installation.
22. Go to 3. Configuring the IP Addresses.
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2. Adding NIC and Promiscuous Port Monitoring on an
Open vSwitch (Flow Sensors Only)
To add additional NICs for the Flow Sensor VE monitoring ports and to complete the
installation, complete the following steps:

1. In the Configuration Menu, click Add Hardware. The Add New Virtual Hardware
dialog box displays.

2. In the left navigation pane, click Network.
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3. Click the Portgroup drop-down list to select an unassigned promiscuous port
group you want to monitor. Click the Device Model drop-down list to select
e1000.

4. Click Finish.
5. If you need to add another monitoring port, repeat these instructions.
6. After you have added all monitoring ports, click Begin Installation.
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3. Configuring the IP Addresses
After you install the Stealthwatch VE appliances using VMware or KVM, you are ready to
configure the basic virtual environment for them.

Configure the IP Addresses
1. Connect to your Hypervisor host (virtual machine host).
2. In the Hypervisor host, locate your virtual machine.
3. Confirm the virtual machine is powered on.
If the virtual machine does not power on, and you receive an error message about
insufficient available memory, do one of the following:
l

l

Resources: Increase the available resources on the system where the
appliance is installed. Refer to the Virtual Edition (VE) Resource
Requirements section for details.
VMware Environment: Increase the memory reservation limit for the
appliance and its resource pool.

Review Resource Requirements to allocate sufficient resources. This step is
critical for system performance.
If you choose to deploy Cisco Stealthwatch appliances without the required
resources, you assume the responsibility to closely monitor your appliance
resource utilization and increase resources as needed to ensure proper health
and function of the deployment.

4. Access the virtual machine console.
5. Allow the virtual appliance to finish booting up. The virtual appliance
Administrative IP Address page opens.
If the Administrative IP address page doesn't open automatically, log in through
the console.
l

Login: sysadmin

l

Default Password: lan1cope

l

You will change the default password when you configure the system.
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You may need to enable the Full Screen Mode to view the entire screen.

6. Click on the page. Enter the IP address for the virtual appliance.
7. Select OK. Press Enter.
8. Review the IP network mask address.
l

Accept the default or enter a new address.

l

Select OK. Press Enter to continue.

9. Review the broadcast IP address.
l

Accept the default or enter a new address.

l

Select OK. Press Enter to continue.
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10. Review the gateway server IP address.
l

Accept the default or enter a new address.

l

Select OK. Press Enter to continue.

11. Enter the host name.
Make sure the host name is unique and meets the Internet standard requirements
for Internet hosts.
l

Select OK.

l

Press Enter to continue.

12. Enter the network domain name.
Use a fully qualified domain name.
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l

Select OK.

l

Press Enter to continue.

13. Review your configuration settings. If everything is correct, press Enter.

14. Follow the on-screen prompts to finish the virtual environment and restart the
appliance.

15. After the restart, the login prompt displays.
If you cannot access the appliance, please refer to Troubleshooting for
instructions.

16. Select No. Press Enter.
17. Press Ctrl + Alt to exit the console.
18. Repeat all the steps in 3. Configuring the IP Addresses for the next virtual
appliance in your system.
If you've configured the IP address on all your virtual appliances, go to 4.

Configuring Your Appliances
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Troubleshooting
Accessing the Appliance
If you cannot access the appliance after it restarts, do the following:

1. Log in as root.
2. Run the following commands and confirm the docker containers and services are
up and running:
l

docker ps

l

systemctl list-units --failed

l

systemd-analyze critical chain

3. Once all docker containers and services are up and running, try the login again. If
you cannot access the appliance, please contact Cisco Stealthwatch Support.
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When you log in to the appliance for the first time, you will use the Appliance Setup Tool
to configure your appliance settings.

Preparation
Refer to the Introduction for the information you need to configure your appliances.

Appliance Setup Tool Requirements
l

Confirm your firewalls and ACLs (Access Control List) will allow access.

l

Gather the host name for the appliance and IP addresses for the following:
l

appliance

l

subnet mask

l

default and broadcast gateways

l

NTP and DNS servers

l

SMC IP address for Central Management

Managed or Stand-Alone
As part of the Appliance Setup Tool, you can configure your appliance to be managed by
your primary SMC or operate as a stand-alone appliance. Certain appliances are
managed automatically. Refer to Configuration Order for details.
l

SMC Management: When your appliances are managed by your Stealthwatch
Management Console (SMC), you can use Central Management to edit appliance
configurations, update software, reboot, shut down, and more.

l

Stand-Alone Appliances: If an appliance is not managed by the SMC, it is
described as a stand-alone appliance. Refer to Configuration Order (Central
Management column) for the list of appliances that can operate as stand-alone.
With the exception of the Endpoint Concentrator, we recommend that you set
up all appliances so they are managed by your primary SMC.

SMC Failover
If you have more than one SMC, you can set up an SMC failover pair so that one of them
serves as backup console to the other.
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l

Use the Appliance Setup Tool to configure each individual SMC.

l

Plan which SMC will be primary and secondary.

l

After you set up each individual SMC, you will use the Central Management Trust
Store and the Stealthwatch Desktop Client to configure the SMC failover
relationship. Refer to Defining an SMC Failover Relationship for details.

Best Practices
To configure your system successfully, make sure you follow the instructions in this
guide.
We recommend the following:
l

One at a Time: Configure one appliance at a time. Confirm the appliance is Up
before you start configuring the next appliance in your cluster.

l

Order: Follow the configuration order.

l

Managed: Set up your appliances so they are managed by your primary SMC
when possible.

l

Multiple Central Managers: You can configure more than one Central Manager in
your system. However, each appliance can be managed by only one primary
SMC/Central Manager.

l

Access: You need administrator privileges to access Central Management.

© 2021 Cisco Systems, Inc. and/or its affiliates. All rights reserved.

- 92 -

4. Configuring Your Appliances

Configuration Order
Configure your appliances in the following order, and note the details for each
appliance:

Order

Appliance

Central
Management

Details
Your primary SMC is
your Central Manager.

1.

Primary SMC

Managed

2.

UDP Directors
(also known as
FlowReplicators)

Managed or
Stand-Alone

3.

Flow Collector 5000
Series Database

Managed

Make sure the Flow
Collector 5000 series
database is shown as
Up before you start the
engine configuration.
Make sure the Flow
Collector 5000 series
database is shown as
Up before you start the
engine configuration.

4.

Flow Collector 5000
Series Engine

Managed

5.

All Other Flow Collectors
(NetFlow and sFlow)

Managed

6.

Flow Sensors

Make sure the SMC is
shown as Up before you
start configuring the
next appliance in the
system.

Managed or
Stand-Alone
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7.

Endpoint Concentrator

Secondary SMC
(if used)

8.

Stand-Alone

Managed

Make sure the primary
SMC is shown as Up
before you start the
secondary SMC
configuration.

Your system might not have all the appliances shown here.

1. Log In
Use the following instructions to configure each appliance using the Appliance Setup
Tool.

1. In the address field of your browser, type https:// followed by the IP address of
the appliance.
l

Primary SMC: Configure the primary SMC first.

l

Up: Confirm each appliance is Up before you start configuring the next
appliance in your cluster.

l

Order: Make sure you configure your appliances in order so they
communicate correctly.

If you cannot access the appliance, please refer to the Troubleshooting
instructions in the 3. Configuring the IP Addresses section.

2. Enter the following credentials to log in:
l

User Name: admin

l

Password: lan411cope
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2. Configure the Appliance
When you log in to the appliance for the first time, the Appliance Setup Tool guides you
through each configuration step.
If this is not a first-time installation, go to Troubleshooting to change
appliance network settings such as host name, network domain name, or IP
address.

1. Change Default Password: Enter new passwords for admin, root, and sysadmin.
Click Next to scroll to each user.
Use the following criteria:
l

Length: 8 to 30 characters

l

Change: Make sure the new password is different from the default password
by at least 4 characters.

User

Default Password

admin

lan411cope

root

lan1cope

sysadmin

lan1cope
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The sysadmin and root menus are unavailable if you've already changed the
default passwords during the hardware installation. Refer to the Stealthwatch
x210 Series Hardware Installation Guide for details.

2. Management Network Interface: Review the IP address and network interface
fields. Confirm the default settings are correct. Click Next.
l

Changes: To change this information, confer with your network
administrator and refer to Troubleshooting.

l

IPv6 (optional): To enable IPv6, click IPv6. Check the Enable IPv6 check
box and complete the fields.
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3. Host Name and Domains: Enter the host name and network domain name. Click
Next.
l

Host Name: A unique host name is required for each appliance. If you
assign the same host names to your appliances, they will not install
successfully.
Also, make sure each appliance host name meets the Internet standard
requirements for Internet hosts.

l

Network Domain: A fully qualified domain name is required for each
appliance.

l

Stealthwatch Domain (SMC only): Enter a Stealthwatch domain for your
Stealthwatch appliances.

l

IP Address Ranges (SMC only): Select the IP address range for your
Stealthwatch network.
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4. DNS Settings: Confirm the default is correct, or enter your domain server IP
address. Click Next.
Add or Delete DNS Servers (optional):
l

Add: Click the + icon.

l

Delete: Click the check box to select the DNS server. Click the - icon.

5. NTP Settings: Confirm the default is correct, or click the Menu icon to select
your network time protocol (NTP) server. Click Next.

l

Multiple NTP Servers: We recommend setting up multiple NTP servers for
redundancy and accuracy.

l

Public Source: pool.ntp.org is a good, public source for NTP.

Add or Delete NTP Servers (optional):
l

Add: Click the + icon.

l

Delete: Click the check box to select the NTP server. Click the - icon.

6. Central Management: UDP Directors, and Flow Sensors: Select whether the
appliance will be managed by your primary SMC or operate as a stand-alone
appliance.
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l

Managed by the primary SMC: Select Yes. Follow the on-screen prompts
to trust the SMC certificate and allow communication with the SMC.
l

Enter the primary SMC login credentials.

l

Select your Stealthwatch Domain.

l

Stand-Alone Appliance: Select No.

l

Flow Sensors: If the appliance will be managed by the primary SMC, select
a Flow Collector.
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l

Flow Collectors: You will configure the appliance for Central Management
in a later step.

7. Review Your Settings: Confirm the appliance information is accurate. Click
Apply or Restart and Proceed.
8. Follow the on-screen prompts while the appliance restarts.
9. Wait a few minutes for your new system settings to take effect. You may need to
refresh the page.

10. Go to the next procedure for the appliance you are configuring.
l

l

l

l

Primary SMC: If the appliance is a primary SMC, go to 4. Confirm
Appliance Status
Flow Collectors: Go to 3. Configure your Flow Collectors for Central
Management
Managed Appliances: If the appliance is managed by the SMC, go to 4.
Confirm Appliance Status
Stand-Alone Appliances: If the appliance is not managed by the SMC, go
to 5. Finishing Appliance Configurations. You will finish the appliance
configuration using the Appliance Admin interface.

3. Configure your Flow Collectors for Central Management
Use the following instructions to finish configuring your Flow Collector so it
communicates with your primary SMC/Central Manager.
If the appliance is not a Flow Collector, skip this procedure. Go to 4. Confirm

Appliance Status
1. Log in to the Flow Collector.
2. The Appliance Setup Tool opens again. Click Continue.
3. On the Central Management tab, select or enter the IP address of your primary
SMC. Click Save.
4. Follow the on-screen prompts to trust the primary SMC appliance identity
certificate. Click Yes to trust the certificate and allow the appliance to
communicate with the SMC.

5. Enter the login credentials for your primary SMC.
6. Select your Stealthwatch Domain.
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7. Enter the Flow Collection Port number. Click Next.
l

Netflow Default: 2055

l

sFlow Default: 6343

8. Click Go to Central Management. Go to 4. Confirm Appliance Status .

4. Confirm Appliance Status
After you configure an appliance in the Appliance Setup Tool, confirm the appliance
status in Central Management.

1. Open Central Management.
l

Log in to your primary SMC.

l

Click the Global Settings icon.

l

Select Central Management.
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2. Review the appliances on the Appliance Manager inventory.
l

Confirm the appliance is shown in the inventory.

l

Confirm the status for the appliance is shown as Up.

Confirming the SMC is Up

Reviewing Appliance Status in Central Management

Make sure the primary SMC and each appliance is shown as Up before you start
configuring the next appliance in your cluster using the configuration order

and details.
3. To configure the next appliance in your system, go to 1. Log In, and complete the
procedures through 4. Confirm Appliance Status .
If you don't have another appliance to set up, go to 5. Finishing Appliance
Configurations.
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5. Finishing Appliance Configurations
Use the following instructions to finish configuring each appliance.
Depending on the speed of your VM host, it may take approximately 30 minutes
for all services to boot up.

1. Click the link for the appliance you are configuring:

Appliance

Required
Configurations

Optional
Configurations

Flow Collector

n/a

n/a
High Availability

UDP Director

(available on hardware
only)

Flow Sensor

Application ID and
Payload

Endpoint Concentrator

Connecting to a NetFlow
Collector

Identifying Applications

2. When you are finished configuring and restarting each appliance in the table, go to
6. Activating Licenses.
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UDP Director
Use the following instructions to finish configuring the UDP Director.
High Availability is only available on UDP Director hardware appliances. High
Availability is not available on virtual appliances.

Forwarding Rules: Configure at least one forwarding rule if you're planning to set up
High Availability.
l

l

Managed: If the appliance is managed by the SMC, go to Configuring
Forwarding Rules Using the SMC
Stand-Alone: If the UDP Director is not managed by an SMC, go to Configuring
Forwarding Rules Using Appliance Administration.

High Availability: If you have more than one UDP Director, you can set up a High
Availability pair. Configure at least one forwarding rule if you're planning to set up High
Availability (go to Configuring High Availability Using Appliance Administration).

Configuring Forwarding Rules Using the SMC
SSL is used to send messages from the UDP Director to the Stealthwatch Management
Console (SMC).

1. Log in to the SMC.
2. Click the Global Settings icon. Select UDP Director Configuration.

3. Click the Actions menu for the appliance. Select Configure Forwarding Rules.
4. Click Add New Rule.
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5. Description: Enter a brief description that identifies the rule.
6. Source IP Address:Port: Type the IP address of the device that sends data to
the UDP Director and the input port number (where the data will be sent).
l

Format: Use the syntax [IP address]:[Port Number].

l

Range: You can use Classless Inter-Domain Routing (CIDR) notation to
enter a range of IP addresses.

l

All: You can type "All" to accept data from any source IP address on this port.

l

Combinations: You can add Source IP Address:Port combinations within a
rule by adding them to a new line.

Examples:
l

10.11.16.38:5322

l

192.168.0.0/16:9000
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l

All:2055

7. Destination IP Address: Enter the IP address of the device receiving data from
the UDP Director.

8. Destination Port Number: Enter the port number for the receiving device.
9. Click Save.
10. Optional: To sync your changes, click Sync.
11. Repeat the procedure to add forwarding rules as needed.
12. To set up a High Availability pair, go to Configuring High Availability Using
Appliance Administration.
High Availability is only available on UDP Director hardware appliances. High
Availability is not available on virtual appliances.
If you do not need to set up a High Availability pair, return to 5. Finishing
Appliance Configurations.

Configuring Forwarding Rules Using Appliance Administration
If you are not managing the UDP Director from the SMC, you can configure the
forwarding rules on the Appliance Admin.
l

Exporter: Configure the exporter to send flows to be forwarded to the IP address
of eth0. The UDP Director will then forward these from eth0 while preserving the
original IP and MAC address of each exporter for forwarded packets.

l

For promiscuous reception, use a span filter for all traffic of interest. The
network must allow traffic on the ports being used from the exporters to the UDP
Director and then to the receivers (ACLs).

1. Log in to the UDP Director Appliance Admin interface.
2. Click Configuration > Forwarding Rules.
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3. Description: Enter a description of the rule.
4. Source IP Address:Port List: Type the IP address of the device that sends data
to the UDP Director and the input port number (where the data will be sent).
l

Format: Use the syntax [IP address]:[Port Number].

l

Range: You can use Classless Inter-Domain Routing (CIDR) notation to
enter a range of IP addresses.

l

All: You can type "All" to accept data from any source IP address on this port.

Using many individual IP addresses for the input causes the engine to work
harder.
l

Substitute Ports: You can use substitute ports for the input traffic and then
redirect that traffic to the desired output ports.
For example, rather than sending all port 55431 traffic to one rule, you can
break up that traffic by having 1/3 of the exporters that formerly used port
55431 to use a dummy port of 44440 instead. Then you can have 1/3 of the
exporters use port 44441, and 1/3 of the exporters use port 44442. Then
redirect all that traffic for ports 44440, 44441, and 44442 to the single
destination port of 55431.
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5. Destination IP Address: Enter the IP address of the device receiving data from
the UDP Director.

6. Destination Port Number: Enter the port number for the receiving device.
7. If you have more than one device sending data to the UDP Director to be
forwarded to another receiving device, click Add.
Repeat this procedure until you have entered all devices for this UDP Director.

8. Click Apply to save your forwarding rules.
The UDP Director Configuration screen refreshes and the system updates the
configuration file.

9. Repeat the procedure to add forwarding rules as needed.
10. To set up a High Availability pair, go to Configuring High Availability Using
Appliance Administration.
High Availability is only available on UDP Director hardware appliances. High
Availability is not available on virtual appliances.
If you do not need to set up a High Availability pair, restart the appliance. Select
Operations > Restart Appliance. Then, return to 5. Finishing Appliance
Configurations.

Configuring High Availability Using Appliance Administration
If you have more than one UDP Director, use the Appliance Admin interface to configure
high availability.
High Availability is only available on UDP Director hardware appliances. High
Availability is not available on virtual appliances.
The UDP Director High Availability allows a user to configure settings for redundant UDP
Directors. Both nodes are fully redundant, however only one node is online at a time.

Primary Node and Secondary Node
The online node is known as the Primary in the pair, while the offline node is the
Secondary. If the Primary node in the pair should fail, the Secondary node takes over
and becomes the Primary.
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Requirements
l

Forwarding Rules: Configure at least one forwarding rule for the UDP Director in
the HA system.

l

Save the Rules Configuration File: If the UDP Director has already been
configured with rules, export (save the rules configuration file) the UDP Director
rules. Then, import the file to the second UDP Director to ensure that the rules for
each match.

l

Order: Configure the Primary UDP Director and then repeat the configuration on
the Secondary one.

l

New or Established: If the both UDP Directors are new, make sure you follow the
procedures for each in this guide. However, if the secondary is already configured
as an appliance on the Stealthwatch system, log in to the secondary UDP Director
and configure its HA components as described here.

1. Configure the Primary UDP Director HA
1. Log in to the primary UDP Director Appliance Admin interface.
2. Click Configuration > High Availability.
3. Check the Enable High Availability check box for the High Availability Settings.
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4. In the Virtual IP Address and the Subnet Mask fields, type the IP addresses for the
primary UDP Director. (They are the same for the secondary.)
The Virtual IP Address should be in the same subnet as the unicast addresses.

5. In the Shared Secret field, type a string for both UDP Directors. (This will be
encrypted for secure transfer.)

6. In the fields for Sync Ring 1 (Eth2) Unicast IP Address, enter the IP address and
the subnet mask. (A Unicast IP Address identifies a single network destination.)

7. In the fields for Sync Ring 2 (Eth3) Unicast IP Address, enter the IP address and
the subnet mask.
Each of the IP addresses--eth0, eth02, eth03--must be on its own separate
unicast subnet.

8. After reviewing the setting, click Apply to set the configuration.
9. Continue to the next section to configure the second UDP Director of the cluster.
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2. Configure the Secondary UDP Director HA
To configure the secondary UDP Director complete the following steps:

1. Log in to the secondary UDP Director Appliance Admin interface.
2. Click Configuration > High Availability.
3. Configure all of the parameters on this screen (including any Advanced Parameters
that you may have changed on the first appliance) exactly as you did on the first
appliance with exactly same values for every field except for the following:
l

l

Sync Ring 1 (Eth2) Unicast IP Address: Enter a different IP address from what
you configured in this field on the primary, but it must be in the same subnet
as the Sync Ring 1 Unicast address given on the primary.
Sync Ring 2 (Eth3) Unicast IP Address: Enter a different IP address from what
you configured in this field on the primary, but it must be in the same subnet
as the Sync Ring 2 Unicast address given on the primary.

4. Click Apply to save your changes and to start the clustering services on this
appliance.

5. Click Promote to designate the primary appliance.
6. Restart: Select Operations > Restart Appliance.
7. Return to 5. Finishing Appliance Configurations.
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Flow Sensor
1. Configure the Application ID and Payload
The configuration of a Flow Sensor requires an additional step of configuring the
application ID and payload.

1. Log in to the Flow Sensor Appliance Admin interface.
2. Click Configuration > Advanced Settings.
The Export settings page opens.

3. Select the proper settings for your network:
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Item

Description

Export Packet
Payload

Allows you to specify whether the Flow Sensor includes the first 26
bytes of binary payload data in the data that it sends to the collector.
Allows you to specify whether the Flow Sensor attempts to identify
applications before sending data to the collector. In addition, this
setting must be enabled for the following settings to take affect:
Include IPv6 – Allows you to specify whether or not the Flow Sensor
analyzes both IPv4 and IPv6 packets. When this setting is disabled,
the Flow Sensor analyzes only IPv4 packets.

Export
Applications
Identification

Export HTTPS Header Data – Allows you to specify whether the Flow
Sensor includes header data from HTTPS flows in the data that it
sends to the collector. The data includes the SSL common name and
SSL organization name. This setting requires that the Flow Type is
set to IPFIX. The maximum is 256 bytes.

Export HTTP Header Data – Allows you to specify whether or not the
Flow Sensor includes header data from HTTP flows in the data that it
sends to the collector. When this setting is selected, a secondary
field allows you to specify the maximum length of the HTTP path (in
bytes) that the Flow Sensor includes as part of the flow data. This
setting requires that the Flow Type is set to IPFIX.

Enable VXLAN
Decapsulation

Allows you to specify whether the Flow Sensor uses Virtual
Extensible Local Area Network (VXLAN) decapsulation capabilities.
Without VXLAN decapsulation, the Flow Sensor simply detects
VXLAN encapsulated traffic as flows between two Virtual Tunnel
Endpoints (VTEPs). Decapsulation allows for much richer content by
being able to analyze the tunneled traffic and thus gain greater
insight into the traffic patterns in the network.
The Flow Sensor will only decapsulate VXLAN traffic which
was originally sent to the standard VXLAN port (4789).

Enable X-

Allows you to specify whether the Flow Sensor uses X-Forwarded-
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Item

Forwarded-For
Processing

Description
For (XFF) processing to identify the originating IP address of a client
connecting to a web server through an HTTP proxy or a load
balancer.
ETA and X-Forwarded-For Processing cannot be
configured together.
Allows you to specify whether the Flow Sensor uses ETA
processing to generate and transmit IDP and SPLT fields to your
SMC.
Enabling ETA increases NetFlow bandwidth usage,
especially when using v9. We recommend using IPFIX for
the Flow Export Format.

Enable ETA
Processing

ETA and X-Forwarded-For Processing cannot be
configured together.
ETA cannot be enabled on Dell or PowerEdge Flow Sensor
models.
Flow Export
Format

Allows you to specify whether the Flow Sensor uses IPFIX or
NetFlow v9 to send flow data to the collector.
Allows you to select one of the following settings:

Use single, shared, cache for all monitoring ports –

Cache Mode

l

Use when asymmetric routing is present.

l

Single state table for application and latency calculations.

l

Uses less memory.

l

Lower overall pps processing rates.

l

l

Results in one NetFlow event created across multiple
interfaces.
Use only when the Flow Sensor has only two ports and is
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Item

Description
connected by a TAP

Use independent caches for each monitoring port –
l

Allows deduplication of packets across each Flow Sensor
interface.

l

Uses more memory.

l

Higher overall pps processing rates.

l

l

Each interface maintains its own latency and application
database.
Results in a unique NetFlow record for each interface that sees
a given packet.

4. Click Apply to save your settings.

2. Configure the Flow Sensor to Identify Applications (optional)
If you want the Flow Sensor to identify applications, configure the following settings:

1. Log in to the Flow Sensor Appliance Admin interface.
2. Click Configuration > Advanced Settings
3. Check the Export Application Identification check box. By default, this option is
not selected.

4. If you have more than 1 monitoring NIC, select one of the following options in the
Cache Mode section:
l

Use single, shared, cache for all monitoring ports: typically used for
systems that monitor flows using the TAP method.

l

Use independent caches for each monitoring port: typically used to
experience better performance and for systems that monitor flows using the
SPAN method.
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3. Restart the Appliance
1. Select Operations > Restart Appliance.
2. Return to 5. Finishing Appliance Configurations.
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Endpoint Concentrator
The Endpoint Concentrator has the following configuration requirements:
l

l

Configure the connection to a NetFlow Flow Collector from the Endpoint
appliance.
You can set only one Flow Collector.

1. Log in to the Endpoint Concentrator.
2. Click Configuration > Collection.
3. In the Assign NetFlow Collector fields, type the IP Address and the port number of
the Flow Collector or UDP Director that you want the Endpoint Concentrator to
send the data to.

Port Default: 2055.
4. Click Add. This will validate the IP address and port and move the entry to the
table.

5. If the information is correct, click Apply. This will restart the services with the new
information.
This field will only accept one value. If you need to add recipients, consider using
a Cisco UDP Director.
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The NetFlow Collector settings appear in the table at the top of the page.
If you need to change the setting for the Collector, first delete the current
Collector by clicking the Delete check box, and then clicking Apply. Then you can
configure a new Collector.

6. In the main menu, click Home. Check the Docker Services table:

7. If all docker services are shown as "Running," restart the Appliance. Select
Operations > Restart Appliance. Then, return to 5. Finishing Appliance
Configurations.
If any docker services are not shown as Running, go to Troubleshooting the
Endpoint Concentrator.
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Troubleshooting the Endpoint Concentrator
After the AnyConnect Agents and the Endpoint Concentrator have been configured,
there are a few items that can be checked to determine if the system is operational.
These steps may be used if it is determined that the system is not processing data as
expected.

1. Validate that the Endpoint Concentrator is receiving flows from the AnyConnect
Agents to the Collector.
l

Enable SSH access to the Endpoint Concentrator via the web admin page.

l

Configuration > Services – Check Enable SSH

2. SSH into the Endpoint Concentrator, run “docker ps”:
l

l

Validate that there are four entries that contain kafka, netflow-parser,
zookeeper, and netflow-generator. Note that the Container IDs and Image
versions will differ.
If not they are not running, restart the Services from the appliance.

3. Change Directories to “/lancope/var/logs/containers” and run “tail –f svcendpoint-engine:vx.x.x.log” where x.x.x is the version indicated in the file name.
Verify in the Stats print out that the counts are not zero. If the stats read as below,
the Endpoint Concentrator is not producing Netflow.

4. Validate AnyConnect Agents can send data to the Endpoint Concentrator.
l

l

On one of the machines running the AnyConnect Agent, open a terminal or
command prompt and run “ping <IPofEndpointConcentrator>”.
If there are response bytes, the Agent most likely can export to the Endpoint
Concentrator.
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6. Activating Licenses
Use the Stealthwatch Downloading and Licensing Guide to activate licenses on your
appliances.
l

Download Licenses: Log in to https://stealthwatch.flexnetoperations.com.

l

Managed: If the appliance is managed by the SMC, activate licenses from the
Stealthwatch Desktop Client.

l

Stand-Alone: If the appliance is stand-alone, activate its licenses from the
individual Appliance Admin interface.
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7. Installing the Stealthwatch Desktop
Client
Use the following instructions to install the Stealthwatch Desktop Client using Windows
or macOS. Note the following:
l
l

l

l

l

l

You can locally install different versions of Stealthwatch Desktop Client.
If you want to access multiple versions of Stealthwatch Desktop Client, you will
need a different executable file for each SMC.
If you are using both a primary and a secondary SMC, you will need to log off one
SMC before you can log in to the other SMC.
You can have different versions of Stealthwatch Desktop Client open
simultaneously.
When you update to a later version of Stealthwatch, you will need to install the
new version of Stealthwatch Desktop Client.
If you have Stealthwatch Desktop Client and update to 7.0.x or later, you can no
longer use Oracle Java with Stealthwatch Desktop Client.

Install the Desktop Client Using Windows
l
l

You must have sufficient rights to install Stealthwatch Desktop Client.
Stealthwatch Desktop Client requires a 64-bit operating system. It
cannot run on a 32-bit operating system or Linux.

1. Click Desktop Client in the upper right corner of any page in the
Stealthwatch Web App.

2. Click the .exe file to begin the installation process.
3. Follow the steps in the wizard to install the Stealthwatch Desktop Client.
4. On your desktop, click the Stealthwatch Desktop Client icon

.

5. Enter the SMC user name and password.
6. Enter the SMC server name or IP address (IPv4 or IPv6).
7. Follow the on-screen prompts to open the Desktop Client and trust the appliance
identity certificate.
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Change the Memory Size
You can change how much Random Access Memory (RAM) to allocate on your client
computer to run the Stealthwatch Desktop Client interface. Consider a larger memory
allocation if you work with many open documents or large data sets (such as flow
queries with over 100k records).

1. In Windows Explorer, go to your home directory.
2. Open these folders: AppData > Roaming > Stealthwatch.
You may need to search "Stealthwatch" if the folder is hidden.

3. In the Stealthwatch directory, open the folder that contains the desired
Stealthwatch version.

4. Open the application.vmoptions file using an appropriate editing application to
begin editing. (This file is created after you open the Stealthwatch Desktop Client
for the first time.)

Minimum Memory Size (Xms): We recommend that you allocate no less than
512 MB. This number is listed in the third line of the file.
For editors that display the content in one continuous line, refer to the number
highlighted in the image below to see which number represents the minimum
memory size.

Maximum Memory (Xmx): You can allocate up to half the size of your computer's
RAM for the maximum memory size. This number is listed in the fourth line of the
file.
For editors that display the content in one continuous line, refer to the number
highlighted in the image below to see which number represents the maximum
memory size.

Use whole numbers. For example, enter Xmx512m, not Xmx0.5m.

l

l

If you notice that the Stealthwatch Desktop Client appears to "hang"
frequently, try increasing the memory size.
If you receive an error message involving Java, try selecting a lower
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memory allocation.

Install the Desktop Client Using macOS
l
l

You must have sufficient rights to install Stealthwatch Desktop Client.
Stealthwatch Desktop Client requires a 64-bit operating system. It
cannot run on a 32-bit operating system or Linux.

1. Click Desktop Client in the upper right corner of any page in the
Stealthwatch Web App.

2. Click the .dmg file to begin the installation process.
An icon and folder are displayed on your monitor, as shown below.

3. Drag the Stealthwatch Desktop Client icon (

) into the Application folder.

The icon is added to the Launchpad.

4. On your desktop, click the Stealthwatch Desktop Client icon

.

5. Enter the SMC user name and password.
6. Enter the SMC server name or IP address (IPv4 or IPv6).
7. Follow the on-screen prompts to open the Desktop Client and trust the appliance
identity certificate.

Change the Memory Size
You can change how much Random Access Memory (RAM) to allocate on your client
computer to run the Stealthwatch Desktop Client interface. Consider a larger memory
allocation if you work with many open documents or large data sets (such as flow
queries with over 100k records).
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1. In Finder, go to your home directory.
2. Open the Stealthwatch folder.
3. In the Stealthwatch directory, open the folder that contains the
desired Stealthwatch version.

4. Open the application.vmoptions file using an appropriate editing application to
begin editing. (This file is created after you open the Stealthwatch Desktop Client
for the first time.)

Minimum Memory Size (Xms): We recommend that you allocate no less than
512 MB. This number is listed in the third line of the file.
For editors that display the content in one continuous line, refer to the number
highlighted in the image below to see which number represents the minimum
memory size.

Maximum Memory Size (Xmx): You can allocate up to half the size of your
computer's RAM for the maximum memory size. This number is listed in the fourth
line of the file.
For editors that display the content in one continuous line, refer to the number
highlighted in the image below to see which number represents the maximum
memory size.

Use whole numbers. For example, enter Xmx512m, not Xmx0.5m.

l

l

If you notice that the Stealthwatch Desktop Client appears to "hang"
frequently, try increasing the memory size.
If you receive an error message involving Java, try selecting a lower
memory allocation.
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8. Verifying Communications
Overview
After you license the Stealthwatch appliances, confirm the SMC is receiving NetFlow
data.
Before you start this procedure, make sure you wait 30 minutes after you
finished the licensing requirements for each appliance.

Verify NetFlow Data Collection
1. In the Stealthwatch Desktop Client Enterprise tree, right-click the Flow Collector.
Select Status > NetFlow Collection Status.

2. On the NetFlow Collection Status page, look at the Current NetFlow Traffic field
located at the top of the document. This statistic shows the amount of NetFlow
traffic being observed.
l
l

If traffic is shown, go to the next step.
If traffic is not shown, check your exporter/router configurations. For details,
refer to the SMC Client Online Help. Then, go to the next step.
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3. Look at the Longest Duration Export column.
Add Column: To add this column to your dashboard, right-click a column heading
and select Longest Duration Export from the menu.
4. Is the value for each exporter below 100?
l
l

If yes, the cache export timer is fine.
If no, higher values indicate an incorrect cache export timer, which may
result in unrealistic alarms. Check your exporter/router configurations. For
details, refer to the SMC Client Online Help.

5. Congratulations! You are finished with your Stealthwatch system configuration.
To add more services and features to Stealthwatch, refer to the following
resources:
l

SMC Failover: To set up an SMC failover pair, refer to the procedure in this
guide.

l

SLIC: Refer to the SLIC procedure in this guide.

l

SAML SSO: Refer to the Configuring SAML SSO procedure in this guide.

l

LDAP: Refer to the procedure in Stealthwatch Online Help.

l

ISE or ISE-PIC: Refer to the ISE and ISE-PIC Configuration Guide posted
on Cisco.com.

Refer to Cisco.com to review our Stealthwatch guides and configure additional
features such as Cisco Threat Response, TACACS+, and ISE.
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To start using Stealthwatch, refer to the following sections of this guide:
l

Getting Started: Review the Getting Started with Stealthwatch section
for more information about managing your environment, investigating
behavior, responding to threats, and more.

l

Central Management: Refer to the Central Management section in this
guide for more information about managing your appliances and changing
configuration settings.

l

Troubleshooting: Refer to the Troubleshooting section of this guide.
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Defining an SMC Failover Relationship
You can establish a failover relationship between two Stealthwatch Management
Consoles (SMCs) so that one of them serves as backup console to the other. When you
define the failover relationship, you will designate one SMC as primary and one SMC as
secondary. If the primary is offline, you can manually set the secondary SMC to become
the primary SMC to continue monitoring the system.
To define an SMC failover relationship, follow the instructions in Stealthwatch Online
Help.
l

Configure the secondary SMC first, so the primary SMC can recognize it and
communicate with it.

l

l

Licensing: Make sure you have the SMCRED license that allows you to use the
failover feature, and make sure the SMC licenses match. See the Downloading
and Licensing Stealthwatch Products Guide for information and instructions.
Trust Store Certificates: As part of this procedure, you will add appliance
identity certificates to the required Trust Stores. Make sure you follow the
instructions.

l

Adding/Removing Appliances: Do not add or remove appliances from Central
Management until you've finished the failover configuration and confirmed the
secondary SMC Appliance Status is shown as Up in Central Management.

1. Plan which SMC will be primary and which SMC will be secondary.
2. Log in to the secondary
3. Before you configure the failover roles in the system, review and follow the
instructions in Stealthwatch Online Help.
l

In the Enterprise tree, right-click the SMC.

l

Select Configuration > SMC Failover.

l

Click Help.
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Enabling the SLIC Threat Feed
To enable the SLIC Threat Feed through the Stealthwatch Desktop Client, complete the
following steps.

Copying the SLIC Feed Key
You will need the SLIC Threat Feed Key to enable the feed. Copy the SLIC Feed Key
from either of the following resources:
l

l

The key is provided in the Cisco Threat Intelligence (TI) Feed subscription
purchase confirmation email from Cisco Stealthwatch.
The key is provided in the Download and License Center at
https://stealthwatch.flexnetoperations.com. Your SMC licenses need to be
activated to complete these steps.
Select My Appliances. In the Serial Number column, click the name of your
primary SMC. Locate the Stealthwatch SLIC Threat Feed Subscription in the list
and copy the key.

Enabling the SLIC Threat Key
1. Configure your firewall to allow the following:
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IP Ranges:
l

64.14.29.0/24

l

64.27.162.0/24

Fully Qualified Domain Name:
l

lancope.flexnetoperations.com

2. Log in to the primary SMC Desktop Client as admin.
3. In the SMC Enterprise tree, right-click the Stealthwatch Labs Intelligence Center
branch. Select Configuration > SLIC Threat Feed Configuration.

The SLIC Threat Feed Configuration dialog opens.
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4. Check the Enable the SLIC Threat Feed check box.
5. In the SLIC Feed Key field, type your key.
6. Click OK.
Within 10 minutes, the Enterprise tree updates the Command & Control Servers
(C&C) host group branch to display the list of active C&C servers identified so far.

Help: For further assistance, refer to the Stealthwatch Management Console
User’s Guide or the Desktop Client interface online Help.
Online Help: To access the Online Help, right-click the Stealthwatch Labs
Intelligence Center branch and select Configuration > SLIC Threat Feed
Configuration. Click Help.
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Configuring SAML SSO
Use the following instructions to configure Security Assertion Markup Language Single
Sign-On (SAML SSO). SSO is an authentication process that allows a user to access
multiple applications with one set of credentials.

Support Details
Please note the following configurations are supported or not supported.

Supported

Not Supported

Microsoft Active Directory File Server
(ADFS) for SAML/SSO

Stealthwatch Desktop Client

On-Premise solutions of Microsoft
ADFS

Cloud Services of Microsoft ADFS
Integrated Windows Authentication (IWA)
Additional Proxies
External Services

1. Prepare for Configuration
You need the following information to configure SSO:

Requirement

Details

Identity Provider URL

The URL must use the fully qualified
domain name or IPv4 address.

Identity Provider Certificate

If the IDP URL starts with HTTPS, download
the CA certificate.
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2. Upload Certificates to the Trust Store
If the Identity Service Provider (IDP) URL starts with HTTPS, add the root CA certificate
to the SMC Trust Store.
If the IDP URL does not start with HTTPS, you can skip this step and go to the
next section, 3. Configure the Service Provider.
Use the following instructions to add the root CA certificate to the SMC Trust Store.

1. On the Central Management Appliance Manager page, click the Actions menu for
the SMC.

2. Select Edit Appliance Configuration.
3. On the Appliance Manager > General tab, locate the Trust Store section.
4. Click Add New.
5. In the Friendly Name field, enter a name for the certificate.
6. Click Choose File. Select the new certificate.
7. Click Add Certificate. Confirm the new certificate is shown in the Trust Store list.
8. Click Apply Settings. Follow the on-screen prompts.
9. Up: On the Appliance Manager page, make sure the SMC finishes the
configuration changes and the Appliance Status returns to Up.
Do not force the appliance to reboot while configuration changes are pending.

10. If you have a secondary SMC, repeat this procedure to add the root CA certificate
to the secondary SMC Trust Store.

11. If you have added the root CA certificate to the SMC Trust Stores, go to the next
section.

3. Configure the Service Provider
1. Log in to the SMC console as root.
2. Type SystemConfig. Press Enter.
3. Select Advanced
4. Select SSO.
5. Confirm ssoEnable/Disable is shown as Disabled.
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6. Select IdentityProvider (IDP). Click Continue.
7. Enter the URL where the Identity Provider's configuration file can be downloaded.
Requirements: Enter the fully qualified domain name or IPv4 address.
8. Select DownloadIDP. Follow the on-screen prompts to enable it.
9. Select SaveChanges. Click Continue.
Follow the on-screen prompts to download the IDP configuration file.

10. Select SSO.
11. Review ServiceProvider(SP). Copy the URL. You will use it to configure the
identity provider.
12. Review Status. Confirm it is shown as Ready.
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4. Enable SSO
1. Select ssoEnable/Disable.
2. Follow the on-screen prompts to enable SSO.
3. Select CredentialDescription. Click Continue.
4. Enter a description of the SSO service credentials users need to log in.
5. Click OK.
6. Select DownloadIDP. Disable DownloadIDP until you need to save a new SSO
configuration.
l

Click Continue.

l

Follow the on-screen prompts to disable DownloadIDP.

7. Select SaveChanges. Click Continue.
8. Exit System Configuration.

5. Configure the Identity Provider
1. In the address field of your browser, type the Service Provider URL.
2. Download the Service Provider metadata file sp.xml.
3. Configure the Identity Provider with sp.xml.
4. Make sure the outgoing claim type includes the user email address.
l

For example: If the Attribute store is the Active Directory, set the outgoing
claim type to the email address for the LDAP Attribute type user ID.

l

Microsoft Active Directory File Server (ADFS): If the IDP type is ADFS,
confirm the following custom rule is shown:

c:[Type == "http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname"]
=> issue(Type = "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/nameidentifier",
Issuer = c.Issuer, Value = c.Value, ValueType = c.ValueType, Properties
["http://schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/format"] =
"urn:oasis:names:tc:SAML:2.0:nameid-format:transient", Properties
["http://schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/namequalifier"] =
"http://<IDP FQDN>/adfs/com/adfs/service/trust", Properties
["http://schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/spnamequalifier"] =
"https://<SMC FQDN>/fedlet");
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6. Add an SSO User
Use the following instructions to add an SSO user. Users are authenticated through/by
the Identity Provider.

1. Log in to the SMC (Stealthwatch Web App).
2. Click the Global Settings icon.
3. Select User Management.
4. Select Create > User.
For instructions, click the

User icon. Select Stealthwatch Online Help. For

details about adding users, refer to "Configuring Users."

5. Complete the fields to create a new user. Configure the user as follows:
l

Authentication Service: Select SSO.

l

User Name: Enter the first part of the email address for the IDP account.
Make sure the ID is identical to the one that will be used for SSO at login. For
example, for name@cisco.com, enter "name" in this field.

6. Click Save.
7. Confirm the SSO User is shown in User Management.

7. Test SAML Login
1. Log in to the SMC (Stealthwatch Web App).
2. On the login page, click the drop-down.
3. Select SAML.
4. Click the credentials button.
5. Enter the login credentials. The SMC opens to the Security Insight Dashboard.
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Troubleshooting
Scenario

Notes

Account Lockout

Disable SSO Only from System Configuration
through emergency account access.

Cannot download IDP XML

Make sure the IDP certificate is uploaded to the
SMC Trust Store.

Cannot save IDP configuration

Review the IDP configuration and make sure the
data you entered is accurate and doesn't include
any extra spaces. Also, review the IDP event logs.

Additional Issues

Download a SAML tracer for your browser. Repeat
the SSO login to review the exchanges between
the IDP and SP.
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Getting Started with Stealthwatch
After you have finished configuring your appliances, Stealthwatch Online Help provides
instructions for managing your environment, investigating behavior, responding to
threats, and more.

Overview
For an overview of Stealthwatch, review the information in Stealthwatch Online Help.

1. Click the

User icon.

2. Select Stealthwatch Online Help.
3. At the top of the page, select the Stealthwatch Help menu.
4. Select Stealthwatch Components > Stealthwatch Management Console
(SMC) Overview > About Stealthwatch Web App.

Managing Your Environment
As part of managing your network security, you need to perform several preliminary
tasks. The menus to access each page are shown with each topic below. For
instructions, select the

User icon > Stealthwatch Online Help from any page.

l

Configuring host groups (Configure > Host Group Management)

l

Creating and managing policies (Configure > Policy Management)

l

Building flow searches (Analyze > Flow Search)

l

Managing user permissions for using Stealthwatch (Global Settings icon > User
Management)

Investigating Behavior
For information about investigating alarms, events, hosts, and more, review the
information in Stealthwatch Online Help.

1. Click the

User icon.

2. Select Stealthwatch Online Help.
3. At the top of the page, select the Stealthwatch Help menu.
4. Select Investigating Behavior.
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Responding To Threats
For policy information, review the information in Stealthwatch Online Help.

1. Click the

User icon.

2. Select Stealthwatch Online Help.
3. At the top of the page, select the Stealthwatch Help menu.
4. Select Responding to Threats.
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Central Management
Use Central Management to manage your appliances from your primary SMC. We've
included an overview of Central Management here, and details for each section are
available in Stealthwatch Online Help.
l

About Central Management: When your appliances are managed by Central
Management, you can review their status and manage the following: edit appliance
configuration, update software, reboot, shut down, and more.

l

Stealthwatch Online Help: To open Stealthwatch Online Help, click the
icon. Select Stealthwatch Online Help

User

Central Management and
Appliance Administration Interface
If the appliance is managed by Central Management, you will access functions for your
appliance in Central Management and the Appliance Administration interface (Appliance
Admin) as follows:

Central Management

Appliance Admin Interface

Edit appliance configuration

View system statistics

Review license status (overview)

Manage licenses

Back up configuration files

Back up database files

View audit logs

Create diagnostics packs

Reboot

Network Host and IP Lookup

Shut down

Packet Capture

Update software

Clearing the DNS Cache
Appliance-specific configurations
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Opening Central Management
1. Log in to your primary SMC.
2. Click the Global Settings icon.
3. Select Central Management.

Opening Appliance Admin
You can access the Appliance Admin interface through Central Management or by
logging in to the appliance directly.

Opening Appliance Admin through Central Management
1. On the Central Management Appliance Manager page, click the Actions menu for
the appliance.

2. Select View Appliance Statistics.
3. Log in to the Appliance Administration interface.

Opening Appliance Admin through Direct Login
1. In your browser address bar, type the appliance IP address as follows:
https://<IPAddress>
l

SMC: add /smc/index.html after the IP address.

l

For example: https://1.1.1.1/smc/index.html

2. Press Enter.

Editing Appliance Configuration
1. On the Central Management Appliance Manager page, click the Actions menu for
the appliance.

2. Select Edit Appliance Configuration.
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3. Click the Configuration menu. Select an item from the list.
or
Click each tab to review each configuration category.

4. Make changes to each configuration section as needed. You can edit more than
one configuration category on each configuration tab.
For instructions, click the

User icon.

5. Click Apply Settings. Follow the on-screen prompts to save your configuration
changes.
Some changes require a system reboot. If you prefer to wait, you can revert your
changes and edit your configuration settings and reboot later.
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The appliance reboots automatically. Do not force the appliance to reboot while
configuration changes are pending. To confirm the appliance status is Up,
review the Central Management > Appliance Manager page.

6. Up: On the Appliance Manager page, make sure the appliance finishes the
configuration changes and the Appliance Status returns to Up.

Viewing Appliance Statistics
Hover: For more information about each appliance status, hover your pointer over the
status.
To see system statistics, services, disk usage, and docker services, log in to the
Appliance Admin interface:

1. On the Central Management Appliance Manager page, click the Actions menu for
the appliance.

2. Select View Appliance Statistics.
3. Log in to the Appliance Administration interface.

Removing an Appliance from Central Management
Use the following instructions to remove an appliance from your Central Manager.

1. On the Central Management Appliance Manager page, click the Actions menu for
the appliance.

2. Select Remove This Appliance.
Config Channel Down: If you're removing the appliance because the
configuration channel is down, go to the Config Channel Down procedure in
Troubleshooting for additional instructions.

Central Management: To add the appliance to a different Central Manager, use
the Appliance Setup Tool.
If your appliance has custom certificates, make sure you save the identity
certificate and certificate chain (root and intermediate) to the SMC Trust Store
before you add the appliance to Central Management. Refer to the Trust Store
procedure in Stealthwatch Online Help.
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Adding an Appliance to Central Management
Use the Appliance Setup Tool to add a stand-alone appliance to Central Management. It
is important to review the following:
l

Custom Certificates: If your appliance has custom certificates, make sure you
save the identity certificate and certificate chain (root and intermediate) to its own
Trust Store and the SMC Trust Store before you add the appliance to Central
Management. Refer to the Trust Store procedure in Stealthwatch Online Help.

l

SMC Administration Credentials: You need the SMC, user ID and password to
add an appliance to Central Management.

l

RFD: If you reset the factory defaults on an appliance, you will enter the host
name, domain name, and additional configuration information as part of the
Appliance Setup Tool.

l

New Installations: If this is a new installation and the appliance hasn't been
configured, go to Quick Reference Workflows.
If your appliance has custom certificates, make sure you save the identity
certificate and certificate chain (root and intermediate) to the SMC Trust Store
before you add the appliance to Central Management. Refer to the Trust Store
procedure in Stealthwatch Online Help.

1. Log in to the Appliance Admin interface.
2. In the appliance browser address bar, after the IP address, replace the end of the
URL with /lc-ast:

https://<IPAddress>/lc-ast
3. Press Enter.
4. Click Next to scroll to the Central Management tab.
5. IP Address: Enter the SMC/Central Manager IP address.
6. Click Save.
7. Follow the on-screen prompts to enter the SMC administration credentials and
finish the configuration. Depending on the type of appliance, you may need to
enter additional information.

8. For more information about the Appliance Setup Tool, refer to 4. Configuring
Your Appliances.
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Installing Patches and Updating Software
Make sure you keep Stealthwatch up-to-date by installing the latest patches for your
software version. For details and instructions, visit the Stealthwatch Download and
License Center.
Software updates are also posted to the Stealthwatch Download and License Center.
For a successful update, make sure you follow the instructions in the Stealthwatch
Update Guide.
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Troubleshooting
Config Channel Down
If your Appliance Manager shows Config Channel Down for the appliance status,
check the following:
l
l

l

Communication Settings: Confirm your network communication settings.
Trust Stores: Make sure your appliance identity certificates are saved to the
correct Trust Stores. Review the procedure in Stealthwatch Online Help.
Certificates: If you've changed the appliance identity certificate, check the
procedure and confirm your certificates are saved to the correct Trust Stores. Refer
to Replacing the Appliance Identity for details.

l

License Expiration: Review the Downloading and Licensing Guide for details.

l

Removing an Appliance: If you remove an appliance from Central Management
while the configuration channel is down, make sure you also remove the appliance
from System Configuration:
l

Log in to the appliance console as sysadmin.

l

Type SystemConfig. Press Enter.

l

Select Advanced > RemoveAppliance.

Opening Appliance Administration Interface
You can access the Appliance Admin interface through Central Management or by
logging in to the appliance directly.
You may need to log in to Appliance Admin if your appliance is operating as a standalone appliance, or if you've removed your SMC from Central Manager accidentally.

1. In your browser address bar, type the appliance IP address as follows:
https://<IPAddress>
l

SMC: add /smc/index.html after the IP address.

l

Example: https://1.1.1.1/smc/index.html

2. Press Enter.
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Replacing the Appliance Identity
Each Stealthwatch version 7.x appliance is installed with a unique, self-signed
appliance identity certificate. You can update the appliance identity certificate using the
Update the Appliance Identity procedure shown in Stealthwatch Online Help.

1. Open Central Management > Appliance Manager.
2. Click the Actions menu for the appliance.
3. Select Edit Appliance Configuration.
4. Select the Appliance tab.
5. Locate the SSL/TLS Appliance Identity section.
6. Click Update Identity.
7. In the warning, click the Stealthwatch Online Help link.
8. Follow the instructions to change the certificate and update the Trust Stores.
Your certificates are critical for your system’s security. Improperly modifying
your certificates can stop Stealthwatch appliance communications and cause
data loss.

Changing Appliances After Configuration
To change the appliance host name, network domain name, or IP address, follow the
instructions in Stealthwatch Online Help.
As part of the procedure, you will remove the appliance from Central Management
temporarily, and the appliance identity certificate is replaced automatically. Also, you
may need to check your appliance Trust Stores.
The appliance identity certificate is replaced automatically as part of this
procedure.

If your appliance uses a custom certificate, please contact Cisco
Stealthwatch Support to change these settings. Do not use the instructions
shown here. Make sure you have a copy of the custom certificate and private
key.
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Changing the Host Name
Make sure the host name is unique and meets the Internet standard requirements for
Internet hosts.

1. Open Central Management > Appliance Manager.
2. Click the Actions menu for the appliance.
3. Select Edit Appliance Configuration.
4. Select the Appliance tab.
5. In the Host Naming section, click the Info icon.
6. Click the Stealthwatch Online Help link.
7. Follow the instructions to change the host name.

Changing the Network Domain Name
1. Open Central Management> Appliance Manager.
2. Click the Actions menu for the appliance.
3. Select Edit Appliance Configuration.
4. Select the Appliance tab.
5. In the Host Naming section, click the Info icon.
6. Click the Stealthwatch Online Help link.
7. Follow the instructions to change the network domain name.

Changing IP Address
1. Open Central Management > Appliance Manager.
2. Click the Actions menu for the appliance.
3. Select Edit Appliance Configuration.
4. Select the Appliance tab.
5. In the Network Interfaces section, click the Info icon.
6. Click the Stealthwatch Online Help link.
7. Follow the instructions to change the network domain name.
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Opening the Appliance Setup Tool
Use the following instructions to open the Appliance Setup Tool after you've configured
an appliance.
If you change the host name, network domain name, or IP address using the
Appliance Setup Tool, the appliance identity certificate is replaced
automatically.

If your appliance uses a custom certificate, please contact Cisco
Stealthwatch Support to change these settings. Do not use the instructions
shown here. Make sure you have a copy of the custom certificate and private
key.

1. In the appliance browser address bar, after the IP address, replace the end of the
URL with /lc-ast:

https://<IPAddress>/lc-ast
2. Press Enter.
3. For more information, refer to 4. Configuring Your Appliances.

Changing the Trusted Hosts
You can use System Configuration to change the trusted hosts list from the appliance
defaults. However, please contact Cisco Stealthwatch Support before you change your
trusted hosts.
Please contact Cisco Stealthwatch Support before you change your trusted
hosts.
If you change the trusted hosts list from the defaults, make sure each Stealthwatch
appliance is included in the trusted host list for every other Stealthwatch appliance in
your deployment. Otherwise, the appliances will not be able to communicate with each
other.

1. SSH in to the appliance, or log in to the appliance's console.
2. Log in as sysadmin.
3. Type your password. Press Enter.
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4. Type SystemConfig. Press Enter.
5. Select Trusted Hosts. Press Enter.

Resetting Factory Defaults
Use the following instructions to reset an appliance to its factory defaults (RFD). To
completely erase data, make sure you reset factory defaults twice.
l

RFD twice: To completely erase data, make sure you reset factory defaults twice.

l

Back up Configuration: If you plan to restore the appliance configuration, make
sure you save the backup configuration and database backup files. Refer to
Backup Configuration Files (in Central Management) and Backup/Restore
Database (Appliance Admin interface) topics in the Stealthwatch Online help
for details. To restore the backup after RFD, contact Cisco Stealthwatch Support.
If you reset factory defaults (RFD) on an appliance, all existing data and
configuration information will be deleted and can only be restored if you've
made a backup.
If you reset an appliance to factory defaults, you cannot restore the
configuration using Central Management. For assistance, please contact Cisco
Stealthwatch Support.

1. Log in to the appliance console as sysadmin.
2. Select Recovery > Factory Defaults.
3. Follow the on-screen prompts to reset factory defaults and restart the appliance.
Make sure you RFD each appliance twice to completely erase data.

Enabling/Disabling Admin Users
Use the following instructions to enable or disable the default admin account.

1. SSH in to the appliance, or log in to the appliance console.
2. Log in as sysadmin.
3. Type your password. Press Enter.
4. Select Advanced. Press Enter and scroll down using the down arrow key.
5. Select AdminUserStatus. Press Enter.
6. Follow the on-screen prompts to enable or disable the Admin User account.
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7. Repeat these instructions to enable or disable the Admin User account on all
appliances in your Stealthwatch cluster.

Resetting Passwords
Enabling or Disabling Password Reset
Use the following instructions to enable or disable the password reset function.
If you disable the password reset, and you lose your passwords, you will lose
access to the data saved to your appliance. To access the appliance again,
reset factory defaults and reconfigure it.

1. SSH in to the appliance, or log in to the appliance's console.
2. Log in as sysadmin.
3. Type your password. Press Enter.
4. Type SystemConfig. Press Enter.
5. Select Advanced. Press Enter.
6. Select ConfigResetPassword. Review the menu description. This will switch
your password reset to disable or enable depending on the current setting.

Make sure you read the menu description to confirm you are disabling or
enabling password reset.

7. To proceed, highlight Select. Press Enter.
8. Follow the on-screen prompts to save your changes.
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Resetting Passwords
There are two ways to reset your passwords to their default settings.
l

l

If you have the appliance root password, use Resetting Admin, Sysadmin, and
Root Passwords.
If you do not have the appliance root password, use Resetting Sysadmin and
Root Passwords to reset the sysadmin and root passwords. Then, use
Resetting Admin, Sysadmin, and Root Passwords to reset the admin
password if necessary.

Resetting Admin, Sysadmin, and Root Passwords
Use the following instructions to reset your admin, sysadmin, and root passwords to
the default settings. Then, change the appliance passwords for maximum security.
l

Requirements: You need the appliance root password to complete these
instructions.

l

Other Users: These instructions reset the admin user to the default password.
The individual user passwords will not be changed.

1. SSH in to the appliance.
2. Log in as root.
3. Type systemctl stop lc-tomcat. Press Enter.
4. Type clearPasswd. Press Enter.
5. Type systemctl start lc-tomcat. Press Enter.
This will reset admin, sysadmin, and root passwords to their default values.

User

Default Password

admin

lan411cope

root

lan1cope

sysadmin

lan1cope

Continue with these instructions to change the appliance passwords in System
Configuration.
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Use the following criteria:
l

Length: 8 to 30 characters

l

Change: Make sure the new password is different from the default password
by at least 4 characters.

6. Type SystemConfig. Press Enter.
7. Select Password. Press Enter.
8. Follow the on-screen prompts to enter a new root password.
9. Exit SSH.
10. SSH in to the appliance.
11. Log in as sysadmin.
12. Type SystemConfig. Press Enter.
13. Select Password. Press Enter.
14. Follow the on-screen prompts to enter a new sysadmin password.
15. Exit SSH.
16. Log in to the appliance as admin user.
In the browser address bar, type the appliance IP address as follows:

https://<IPAddress>
17. Click the Global Settings icon. Select User Management.
18. Locate the admin in the list.
19. Click the Actions menu. Select Change Password.
20. Follow the on-screen prompts to change the admin password.

Resetting Sysadmin and Root Passwords
Use console access to reset your appliance root and sysadmin passwords to the
default settings. Then, change the appliance passwords for maximum security.

1. Console to the appliance.
2. Reboot the appliance.
3. When the console screen reaches the GRUB menu, type "e" to enter edit mode.
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4. Advance the cursor to the second line.
The command line might look slightly different depending on your appliance
version.

5. Type resetpassword after c=off to make the command line look like the
following example:

linux /boot/vmlinuz-$kern_ver $kern_args $console_args
pci=reallo\
c=off resetpassword
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6. Type CTRL-X to resume booting.
This will reset both sysadmin and root passwords to their default values.

7. If you need to reset the admin password, go to Resetting Admin, Sysadmin,
and Root Passwords.
If you do not need to reset the admin password, continue with these
instructions to change the appliance root and sysadmin passwords for maximum
security. Use the following criteria:
l

Length: 8 to 30 characters

l

Change: Make sure the new password is different from the default password
by at least 4 characters.

8. Sign in using the default sysadmin credentials:
l

Login: sysadmin

l

Password: lan1cope

9. Select Password.
10. Follow the on-screen prompts to change the sysadmin password.
11. Log out.
12. Sign in using the default root credentials:
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l

Login: root

l

Password: lan1cope

13. Select Password.
14. Follow the on-screen prompts to change the root password.
15. Log out.
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Contacting Support
If you need technical support, please do one of the following:
l

Contact your local Cisco Partner

l

Contact Cisco Stealthwatch Support

l

To open a case by web: http://www.cisco.com/c/en/us/support/index.html

l

To open a case by email: tac@cisco.com

l

For phone support: 1-800-553-2447 (U.S.)

l

For worldwide support numbers:

https://www.cisco.com/c/en/us/support/web/tsd-cisco-worldwidecontacts.html
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